Table of contents

VIPA System 300S CPU

5.11.1 Overview................................................................. 49
5.11.2 Function security..................................................... 51
5.12 Overall reset............................................................. 52
5.13 Firmware update....................................................... 54
5.14 Reset to factory setting.............................................. 56
5.15 Slot for storage media................................................. 56
5.16 Memory extension with MCC................................. 57
5.17 Extended know-how protection............................. 58
5.18 MMC-Cmd - Auto commands................................. 60
5.19 VIPA specific diagnostic entries............................ 62
5.20 Control and monitoring of variables with test functions.. 77

6 Deployment PtP communication........................................ 79
6.1 Fast introduction....................................................... 79
6.2 Principle of the data transfer..................................... 80
6.3 Deployment of RS485 interface for PtP.................... 80
6.4 Parametrization......................................................... 82
6.4.1 FC/SFC 216 - SER_CFG......................................... 82
6.5 Communication........................................................ 85
6.5.1 Overview............................................................... 85
6.5.2 FC/SFC 217 - SER_SND......................................... 85
6.5.3 FC/SFC 218 - SER_RCV......................................... 90
6.6 Protocols and procedures ........................................ 92
6.7 Modbus - Function codes......................................... 96
6.8 Modbus - Example communication........................ 101

7 Deployment PROFIBUS communication........................ 104
7.1 Overview.................................................................. 104
7.2 Deployment as PROFIBUS DP slave......................... 105
7.3 PROFIBUS installation guidelines.......................... 107

8 WinPLC7........................................................................... 111
8.1 System conception.................................................... 111
8.2 Installation............................................................... 111
8.3 Example project engineering.................................. 113
8.3.1 Job definition....................................................... 113
8.3.2 Project engineering.............................................. 113
8.3.3 Test the PLC program in the Simulator............... 119
8.3.4 Transfer PLC program to CPU and its execution.... 120
1 General

1.1 Copyright © VIPA GmbH

This document contains proprietary information of VIPA and is not to be disclosed or used except in accordance with applicable agreements.

This material is protected by the copyright laws. It may not be reproduced, distributed, or altered in any fashion by any entity (either internal or external to VIPA), except in accordance with applicable agreements, contracts or licensing, without the express written consent of VIPA and the business management owner of the material.

For permission to reproduce or distribute, please contact: VIPA, Gesellschaft für Visualisierung und Prozessautomatisierung mbH Ohmstraße 4, D-91074 Herzogenaurach, Germany

Tel.: +49 9132 744 -0
Fax.: +49 9132 744-1864
EMail: info@vipa.de
http://www.vipa.com

Every effort has been made to ensure that the information contained in this document was complete and accurate at the time of publishing. Nevertheless, the authors retain the right to modify the information.

This customer document describes all the hardware units and functions known at the present time. Descriptions may be included for units which are not present at the customer site. The exact scope of delivery is described in the respective purchase contract.

CE Conformity Declaration

Hereby, VIPA GmbH declares that the products and systems are in compliance with the essential requirements and other relevant provisions. Conformity is indicated by the CE marking affixed to the product.

Conformity Information

For more information regarding CE marking and Declaration of Conformity (DoC), please contact your local VIPA customer service organization.
1.2 About this manual

Objective and contents

This manual describes the System 300S SPEED7 CPU 314-2BG03 from VIPA. It contains a description of the construction, project implementation and usage.

<table>
<thead>
<tr>
<th>Product</th>
<th>Order number</th>
<th>as of state:</th>
</tr>
</thead>
<tbody>
<tr>
<td>314SB/DPS</td>
<td>314-2BG03</td>
<td>02</td>
</tr>
<tr>
<td></td>
<td></td>
<td>V3.6.0</td>
</tr>
</tbody>
</table>

Target audience

The manual is targeted at users who have a background in automation technology.

Structure of the manual

The manual consists of chapters. Every chapter provides a self-contained description of a specific topic.
Guide to the document

The following guides are available in the manual:
- An overall table of contents at the beginning of the manual
- References with page numbers

Availability

The manual is available in:
- printed form, on paper
- in electronic form as PDF-file (Adobe Acrobat Reader)

Icons Headings

Important passages in the text are highlighted by following icons and headings:

**DANGER!**
Immediate or likely danger. Personal injury is possible.

**CAUTION!**
Damages to property is likely if these warnings are not heeded.

*Supplementary information and useful tips.*

1.3 Safety information

Applications conforming with specifications

The system is constructed and produced for:
- communication and process control
- industrial applications
- operation within the environmental conditions specified in the technical data
- installation into a cubicle

**DANGER!**
This device is not certified for applications in
- in explosive environments (EX-zone)

Documentation

The manual must be available to all personnel in the
- project design department
- installation department
- commissioning
- operation
CAUTION!
The following conditions must be met before using or commissioning the components described in this manual:

- Hardware modifications to the process control system should only be carried out when the system has been disconnected from power!
- Installation and hardware modifications only by properly trained personnel.
- The national rules and regulations of the respective country must be satisfied (installation, safety, EMC ...)

Disposal

National rules and regulations apply to the disposal of the unit!
2 Basics

2.1 Safety information for users

Handling of electrostatic sensitive modules

VIPA modules make use of highly integrated components in MOS-Technology. These components are extremely sensitive to over-voltages that can occur during electrostatic discharges. The following symbol is attached to modules that can be destroyed by electrostatic discharges.

![Symbol](image)

The Symbol is located on the module, the module rack or on packing material and it indicates the presence of electrostatic sensitive equipment. It is possible that electrostatic sensitive equipment is destroyed by energies and voltages that are far less than the human threshold of perception. These voltages can occur where persons do not discharge themselves before handling electrostatic sensitive modules and they can damage components thereby, causing the module to become inoperable or unusable. Modules that have been damaged by electrostatic discharges can fail after a temperature change, mechanical shock or changes in the electrical load. Only the consequent implementation of protection devices and meticulous attention to the applicable rules and regulations for handling the respective equipment can prevent failures of electrostatic sensitive modules.

Shipping of modules

Modules must be shipped in the original packing material.

Measurements and alterations on electrostatic sensitive modules

When you are conducting measurements on electrostatic sensitive modules you should take the following precautions:

- Floating instruments must be discharged before use.
- Instruments must be grounded.

Modifying electrostatic sensitive modules you should only use soldering irons with grounded tips.

CAUTION!

Personnel and instruments should be grounded when working on electrostatic sensitive modules.

2.2 Operating structure of a CPU

2.2.1 General

The CPU contains a standard processor with internal program memory. In combination with the integrated SPEED7 technology the unit provides a powerful solution for process automation applications within the System 300S family. A CPU supports the following modes of operation:

- cyclic operation
- timer processing
- alarm controlled operation
- priority based processing
Cyclic processing represents the major portion of all the processes that are executed in the CPU. Identical sequences of operations are repeated in a never-ending cycle.

Timer processing

Where a process requires control signals at constant intervals you can initiate certain operations based upon a timer, e.g. not critical monitoring functions at one-second intervals.

Alarm controlled processing

If a process signal requires a quick response you would allocate this signal to an alarm controlled procedure. An alarm can activate a procedure in your program.

Priority based processing

The above processes are handled by the CPU in accordance with their priority. Since a timer or an alarm event requires a quick reaction, the CPU will interrupt the cyclic processing when these high-priority events occur to react to the event. Cyclic processing will resume, once the reaction has been processed. This means that cyclic processing has the lowest priority.

2.2.2 Applications

The program that is present in every CPU is divided as follows:

- System routine
- User application

System routine

The system routine organizes all those functions and procedures of the CPU that are not related to a specific control application.

User application

This consists of all the functions that are required for the processing of a specific control application. The operating modules provide the interfaces to the system routines.

2.2.3 Operands

The following series of operands is available for programming the CPU:

- Process image and periphery
- Bit memory
- Timers and counters
- Data blocks

Process image and periphery

The user application can quickly access the process image of the inputs and outputs PIO/PII. You may manipulate the following types of data:

- individual Bits
- Bytes
- Words
- Double words
You may also gain direct access to peripheral modules via the bus from user application. The following types of data are available:

- Bytes
- Words
- Blocks

**Bit Memory**

The bit memory is an area of memory that is accessible by means of certain operations. Bit memory is intended to store frequently used working data.

You may access the following types of data:

- individual Bits
- Bytes
- Words
- Double words

**Timers and counters**

In your program you may load cells of the timer with a value between 10ms and 9990s. As soon as the user application executes a start-operation, the value of this timer is decremented by the interval that you have specified until it reaches zero.

You may load counter cells with an initial value (max. 999) and increment or decrement these when required.

**Data Blocks**

A data block contains constants or variables in the form of bytes, words or double words. You may always access the current data block by means of operands.

You may access the following types of data:

- individual Bits
- Bytes
- Words
- Double words

### 2.3 CPU 314-2BG03 Overview

The CPU 314-2BG03 bases upon the SPEED7 technology. This supports the CPU at programming and communication by means of co-processors that causes a power improvement for highest needs.

- The CPU is programmed in STEP®7 from Siemens. For this you may use the SIMATIC Manager or TIA Portal from Siemens. Here the instruction set of the S7-400 from Siemens is used.
- Modules and CPUs of the System 300S from VIPA and Siemens may be used at the bus as a mixed configuration.
- The user application is stored in the battery buffered RAM or on an additionally pluggable MMC storage module.
- The CPU is configured as CPU 315-2AG10 (6ES7 315-2AG10-0AB0/V2.6) from Siemens.
Please always use the CPU 315-2AG10 (6ES7 315-2AG10-0AB0/V2.6) from Siemens of the hardware catalog to project this CPU from VIPA. For the project engineering, a thorough knowledge of the Siemens SIMATIC Manager and the hardware configurator from Siemens is required!

Memory

The CPU has an integrated memory. Information about the capacity of the memory may be found at the front of the CPU. The memory is divided into the following parts:

- Load memory 512kbyte
- Code memory (50% of the work memory)
- Data memory (50% of the work memory)
- Work memory 128kbyte
  - There is the possibility to extend the work memory to its maximum printed capacity 512kbyte by means of a MCC memory extension card.

Integrated PROFIBUS DP slave

The CPU has a PROFIBUS DP slave integrated. This is configured during hardware configuration by the PROFIBUS part of the CPU 315-2AG10 (6ES7 315-2AG10-0AB0/V2.6) from Siemens. Here switch during configuration the PROFIBUS part to ‘Operation mode’ slave.
PtP communication

By switching the PROFIBUS part to ‘Master’ operation without linking, the interface may be used for point-to-point (PtP) communication. Here the communication happens by means of VIPA handling blocks.

Integrated Ethernet PG/OP channel

The CPU has an Ethernet interface for PG/OP communication. After assigning IP address parameters with your configuration tool, via the "PLC" functions you may directly access the Ethernet PG/OP channel and program res. remote control your CPU. You may also access the CPU with a visualization software via these connections.

Operation Security

- Wiring by means of spring pressure connections (CageClamps) at the front connector
- Core cross-section 0.08...2.5mm²
- Total isolation of the wiring at module change
- Potential separation of all modules to the backplane bus

Dimensions/ Weight

Dimensions of the basic enclosure:

- 1 tier width: (WxHxD) in mm: 40x125x120

Integrated power supply

The CPU comes with an integrated power supply. The power supply is to be supplied with DC 24V. By means of the supply voltage, the internal electronic is supplied as well as the connected modules via backplane bus. The power supply is protected against inverse polarity and overcurrent.

2.4 General data

Conformity and approval

<table>
<thead>
<tr>
<th>Conformity</th>
<th>Approval</th>
<th>Protection of persons and device protection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conformity</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CE</td>
<td>2006/95/EG</td>
<td>Low-voltage directive</td>
</tr>
<tr>
<td></td>
<td>2004/108/EG</td>
<td>EMC directive</td>
</tr>
<tr>
<td>Approval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UL</td>
<td>UL 508</td>
<td>Approval for USA and Canada</td>
</tr>
<tr>
<td>others</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RoHS</td>
<td>2011/65/EU</td>
<td>Product is lead-free; Restriction of the use of certain hazardous substances in electrical and electronic equipment</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Protection of persons and device protection</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Type of protection</td>
<td></td>
<td>IP20</td>
</tr>
<tr>
<td>Electrical isolation</td>
<td></td>
<td></td>
</tr>
<tr>
<td>to the field bus</td>
<td></td>
<td>electrically isolated</td>
</tr>
<tr>
<td>to the process level</td>
<td></td>
<td>electrically isolated</td>
</tr>
</tbody>
</table>

HB140 | CPU | 314-2BG03 | GB | 14-40
### Protection of persons and device protection

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insulation resistance</td>
<td>-</td>
</tr>
<tr>
<td>Insulation voltage to reference earth</td>
<td>-</td>
</tr>
<tr>
<td>Inputs / outputs</td>
<td>AC / DC 50V, test voltage AC 500V</td>
</tr>
<tr>
<td>Protective measures</td>
<td>against short circuit</td>
</tr>
</tbody>
</table>

### Environmental conditions to EN 61131-2

#### Climatic

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Standard</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage / transport</td>
<td>EN 60068-2-14</td>
<td>-25…+70°C</td>
</tr>
</tbody>
</table>

#### Operation

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Standard</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Horizontal installation</td>
<td>EN 61131-2</td>
<td>0…+60°C</td>
</tr>
<tr>
<td>Vertical installation</td>
<td>EN 61131-2</td>
<td>0…+60°C</td>
</tr>
<tr>
<td>Air humidity</td>
<td>EN 60068-2-30</td>
<td>RH1 (without condensation, rel. humidity 10…95%)</td>
</tr>
<tr>
<td>Pollution</td>
<td>EN 61131-2</td>
<td>Degree of pollution 2</td>
</tr>
</tbody>
</table>

#### Mechanical

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Standard</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oscillation</td>
<td>EN 60068-2-6</td>
<td>1g, 9Hz ... 150Hz</td>
</tr>
<tr>
<td>Shock</td>
<td>EN 60068-2-27</td>
<td>15g, 11ms</td>
</tr>
</tbody>
</table>

### Mounting conditions

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mounting place</td>
<td>In the control cabinet</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal and vertical</td>
</tr>
</tbody>
</table>

### EMC

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Standard</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emitted interfer-</td>
<td>EN 61000-6-4</td>
<td>Class A (Industrial area)</td>
</tr>
<tr>
<td>ence</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Noise immunity</td>
<td>EN 61000-6-2</td>
<td>Industrial area</td>
</tr>
<tr>
<td>zone B</td>
<td>EN 61000-4-2</td>
<td>ESD</td>
</tr>
<tr>
<td></td>
<td>EN 61000-4-3</td>
<td>8kV at air discharge (degree of severity 3),</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4kV at contact discharge (degree of severity 2)</td>
</tr>
<tr>
<td></td>
<td>EN 61000-4-6</td>
<td>HF field immunity (casing)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>80MHz … 1000MHz, 10V/m, 80% AM (1kHz)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1.4GHz ... 2.0GHz, 3V/m, 80% AM (1kHz)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2GHz ... 2.7GHz, 1V/m, 80% AM (1kHz)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>HF conducted</td>
</tr>
<tr>
<td></td>
<td></td>
<td>150kHz … 80MHz, 10V, 80% AM (1kHz)</td>
</tr>
<tr>
<td>EMC</td>
<td>Standard</td>
<td>Comment</td>
</tr>
<tr>
<td>---------</td>
<td>-------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td></td>
<td>EN 61000-4-4</td>
<td>Burst, degree of severity 3</td>
</tr>
<tr>
<td></td>
<td>EN 61000-4-5</td>
<td>Surge, installation class 3 *</td>
</tr>
</tbody>
</table>

*) Due to the high-energetic single pulses with Surge an appropriate external protective circuit with lightning protection elements like conductors for lightning and overvoltage is necessary.
3 Assembly and installation guidelines

3.1 Installation dimensions

**Dimensions Basic**

- 1 tier width (WxHxD) in mm: 40 x 125 x 120

**Dimensions**

![Diagram](image1)

**Installation dimensions**

![Diagram](image2)
3.2 Assembly standard bus

**General**

The single modules are directly installed on a profile rail and connected via the backplane bus connector. Before installing the modules you have to clip the backplane bus connector to the module from the backside. The backplane bus connector is delivered together with the peripheral modules.

<table>
<thead>
<tr>
<th>Order number</th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>390-1AB60</td>
<td>160</td>
<td>140</td>
<td>10</td>
</tr>
<tr>
<td>390-1AE80</td>
<td>482</td>
<td>466</td>
<td>8.3</td>
</tr>
<tr>
<td>390-1AF30</td>
<td>530</td>
<td>500</td>
<td>15</td>
</tr>
<tr>
<td>390-1AJ30</td>
<td>830</td>
<td>800</td>
<td>15</td>
</tr>
<tr>
<td>390-9BC00*</td>
<td>2000</td>
<td>Drillings only left</td>
<td>15</td>
</tr>
</tbody>
</table>

*) Unit pack: 10 pieces

**Bus connector**

For the communication between the modules the System 300S uses a backplane bus connector. Backplane bus connectors are included in the delivering of the peripheral modules and are clipped at the module from the backside before installing it to the profile rail.
Assembly and installation guidelines

VIPA System 300S CPU

Cabling

Assembly possibilities

Please regard the allowed environment temperatures:

- horizontal assembly: from 0 to 60°C
- vertical assembly: from 0 to 40°C
- lying assembly: from 0 to 40°C

Approach

1. Bolt the profile rail with the background (screw size: M6), so that you still have minimum 65mm space above and 40mm below the profile rail.
2. If the background is a grounded metal or device plate, please look for a low-impedance connection between profile rail and background.
3. Connect the profile rail with the protected earth conductor. For this purpose there is a bolt with M6-thread.
4. The minimum cross-section of the cable to the protected earth conductor has to be 10mm².
5. Stick the power supply to the profile rail and pull it to the left side to the grounding bolt of the profile rail.
6. Fix the power supply by screwing.
7. Take a backplane bus connector and click it at the CPU from the backside like shown in the picture.
8. Stick the CPU to the profile rail right from the power supply and pull it to the power supply.
9. Click the CPU downwards and bolt it like shown.
10. Repeat this procedure with the peripheral modules, by clicking a backplane bus connector, stick the module right from the modules you’ve already fixed, click it downwards and connect it with the backplane bus connector of the last module and bolt it.

3.3 Cabling

CAUTION!

- The power supplies must be released before installation and repair tasks, i.e. before handling with the power supply or with the cabling you must disconnect current/voltage (pull plug, at fixed connection switch off the concerning fuse)!
- Installation and modifications only by properly trained personnel!
For the cabling of power supply of a CPU, a green plug with Cage-Clamp technology is deployed. The connection clamp is realized as plug that may be clipped off carefully if it is still cabled.

Here wires with a cross-section of 0.08mm$^2$ to 2.5mm$^2$ may be connected. You can use flexible wires without end case as well as stiff wires.

1. Test point for 2mm test tip
2. Locking (orange) for screwdriver
3. Round opening for wires

The picture on the left side shows the cabling step by step from top view.

1. For cabling you push the locking vertical to the inside with a suiting screwdriver and hold the screwdriver in this position.
2. Insert the de-isolated wire into the round opening. You may use wires with a cross-section from 0.08mm$^2$ to 2.5mm$^2$
3. By removing the screwdriver the wire is connected safely with the plug connector via a spring.

In the following the cabling of the two variants are shown.
1. Open the front flap of your I/O module.

2. Bring the front connector in cabling position.
   For this you plug the front connector on the module until it locks.
   In this position the front connector juts out of the module and
   has no contact yet.

3. De-isolate your wires. If needed, use core end cases.

4. Thread the included cable binder into the front connector.

5. If you want to lead out your cables from the bottom of the
   module, start with the cabling from bottom to top, res. from top
   to bottom, if the cables should be led out at the top.

6. Bolt also the connection screws of not cabled screw clamps.

7. Fix the cable binder for the cable bundle.

8. Push the release key at the front connector on the upper side of
   the module and at the same time push the front connector into
   the module until it locks.

9. Now the front connector is electrically connected with your
   module.

10. Close the front flap.

11. Fill out the labeling strip to mark the single channels and push
    the strip into the front flap.
40pole screw connection 392-1AM00

1. Open the front flap of your I/O module.
2. Bring the front connector in cabling position. For this you plug the front connector on the module until it locks. In this position the front connector juts out of the module and has no contact yet.
3. De-isolate your wires. If needed, use core end cases.
4. If you want to lead out your cables from the bottom of the module, start with the cabling from bottom to top, res. from top to bottom, if the cables should be led out at the top.
5. Bolt also the connection screws of not cabled screw clamps.
6. Put the included cable binder around the cable bundle and the front connector.
7. Fix the cable binder for the cable bundle.
8. Bolt the fixing screw of the front connector.
9. Now the front connector is electrically connected with your module.
10. Close the front flap.
11. Fill out the labeling strip to mark the single channels and push the strip into the front flap.

3.4 Installation guidelines

General

The installation guidelines contain information about the interference free deployment of a PLC system. There is the description of the ways, interference may occur in your PLC, how you can make sure the electromagnetic compatibility (EMC), and how you manage the isolation.
**What does EMC mean?**

Electromagnetic compatibility (EMC) means the ability of an electrical device, to function error free in an electromagnetic environment without being interfered respectively without interfering the environment.

The components of VIPA are developed for the deployment in industrial environments and meets high demands on the EMC. Nevertheless you should project an EMC planning before installing the components and take conceivable interference causes into account.

**Possible interference causes**

Electromagnetic interferences may interfere your control via different ways:

- Electromagnetic fields (RF coupling)
- Magnetic fields with power frequency
- Bus system
- Power supply
- Protected earth conductor

Depending on the spreading medium (lead bound or lead free) and the distance to the interference cause, interferences to your control occur by means of different coupling mechanisms.

There are:

- galvanic coupling
- capacitive coupling
- inductive coupling
- radiant coupling

**Basic rules for EMC**

In the most times it is enough to take care of some elementary rules to guarantee the EMC. Please regard the following basic rules when installing your PLC.

- Take care of a correct area-wide grounding of the inactive metal parts when installing your components.
  - Install a central connection between the ground and the protected earth conductor system.
  - Connect all inactive metal extensive and impedance-low.
  - Please try not to use aluminium parts. Aluminium is easily oxidizing and is therefore less suitable for grounding.
- When cabling, take care of the correct line routing.
  - Organize your cabling in line groups (high voltage, current supply, signal and data lines).
  - Always lay your high voltage lines and signal respectively data lines in separate channels or bundles.
  - Route the signal and data lines as near as possible beside ground areas (e.g. suspension bars, metal rails, tin cabinet).
- Proof the correct fixing of the lead isolation.
  - Data lines must be laid isolated.
  - Analog lines must be laid isolated. When transmitting signals with small amplitudes the one sided laying of the isolation may be favourable.
  - Lay the line isolation extensively on an isolation/protected earth conductor rail directly after the cabinet entry and fix the isolation with cable clamps.
  - Make sure that the isolation/protected earth conductor rail is connected impedance-low with the cabinet.
  - Use metallic or metallised plug cases for isolated data lines.
In special use cases you should appoint special EMC actions.
- Consider to wire all inductivities with erase links.
- Please consider luminescent lamps can influence signal lines.

Create a homogeneous reference potential and ground all electrical operating supplies when possible.
- Please take care for the targeted employment of the grounding actions. The grounding of the PLC serves for protection and functionality activity.
- Connect installation parts and cabinets with your PLC in star topology with the isolation/protected earth conductor system. So you avoid ground loops.
- If there are potential differences between installation parts and cabinets, lay sufficiently dimensioned potential compensation lines.

**Isolation of conductors**

Electrical, magnetically and electromagnetic interference fields are weakened by means of an isolation, one talks of absorption. Via the isolation rail, that is connected conductive with the rack, interference currents are shunt via cable isolation to the ground. Here you have to make sure, that the connection to the protected earth conductor is impedance-low, because otherwise the interference currents may appear as interference cause.

When isolating cables you have to regard the following:

- If possible, use only cables with isolation tangle.
- The hiding power of the isolation should be higher than 80%.
- Normally you should always lay the isolation of cables on both sides. Only by means of the both-sided connection of the isolation you achieve high quality interference suppression in the higher frequency area. Only as exception you may also lay the isolation one-sided. Then you only achieve the absorption of the lower frequencies. A one-sided isolation connection may be convenient, if:
  - the conduction of a potential compensating line is not possible.
  - analog signals (some mV respectively µA) are transferred.
  - foil isolations (static isolations) are used.
- With data lines always use metallic or metallised plugs for serial couplings. Fix the isolation of the data line at the plug rack. Do not lay the isolation on the PIN 1 of the plug bar!
- At stationary operation it is convenient to strip the insulated cable interruption free and lay it on the isolation/protected earth conductor line.
- To fix the isolation tangles use cable clamps out of metal. The clamps must clasp the isolation extensively and have well contact.
- Lay the isolation on an isolation rail directly after the entry of the cable in the cabinet. Lead the isolation further on to your PLC and don’t lay it on there again!

**CAUTION!**
*Please regard at installation!*

At potential differences between the grounding points, there may be a compensation current via the isolation connected at both sides.

Remedy: Potential compensation line
4     Hardware description

4.1 Properties

CPU 314-2BG03

- SPEED7 technology integrated
- 128kbyte work memory integrated (64kbyte code, 64kbyte data)
- Memory expandable to max. 512kbyte (256kbyte code, 256kByte data)
- Load memory 512kbyte
- PROFIBUS DP slave integrated (DP-V0, DP-V1)
- MPI interface
- MCC slot for external memory cards and memory extension (lockable)
- Status LEDs for operating state and diagnosis
- Real-time clock battery buffered
- Ethernet PG/OP interface integrated
- RS485 interface configurable for PROFIBUS DP slave respectively
- I/O address area digital/analog 2048byte
- 512 timer
- 512 counter
- 8192 flag byte

Ordering data

<table>
<thead>
<tr>
<th>Type</th>
<th>Order number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>314SE/DPS</td>
<td>314-2BG03</td>
<td>MPI interface, card slot, real time clock, Ethernet interface for PG/OP, PROFIBUS DP slave</td>
</tr>
</tbody>
</table>
4.2 Structure
4.2.1 General

CPU 314-2BG03

1. LEDs of the integrated PROFIBUS DP master
2. Storage media slot (lockable)
3. LEDs of the CPU part
4. Operating mode switch CPU
5. Slot for DC 24V power supply
6. Twisted pair interface for Ethernet PG/OP channel
7. MPI interface
8. PROFIBUS DP/PtP interface

Components 5 - 8 are under the front flap!

4.2.2 Interfaces

- X1
  - + 1 + DC 24 V
  - - 2 0 V

- X2
  - 1 n. c.
  - 2 M24V
  - 3 Rx/TxD-P (line B)
  - 4 RTS
  - 5 M5V
  - 6 P5V
  - 7 P24V
  - 8 Rx/TxD-N (line A)
  - 9 n. c.

- X3
  - 1 n. c.
  - 2 M24V
  - 3 Rx/TxD-P (line B)
  - 4 RTS
  - 5 M5V
  - 6 P5V
  - 7 P24V
  - 8 Rx/TxD-N (line A)
  - 9 n. c.
Power supply X1

The CPU has an integrated power supply:
- The power supply has to be provided with DC 24V. For this serves the double DC 24V slot, that is underneath the flap.
- Via the power supply not only the internal electronic is provided with voltage, but by means of the backplane bus also the connected modules.
- The power supply is protected against polarity inversion and overcurrent.
- The internal electronic is galvanically connected with the supply voltage.

MPI interface X2

9pin SubD jack:
- The MPI interface serves for the connection between programming unit and CPU.
- By means of this the project engineering and programming happens.
- MPI serves for communication between several CPUs or between HMIs and CPU.
- Standard setting is MPI Address 2.

Ethernet PG/OP channel X4

8pin RJ45 jack:
- The RJ45 jack serves the interface to the Ethernet PG/OP channel.
- This interface allows you to program res. remote control your CPU, to access the internal web site or to connect a visualization.
- Configurable connections are not possible.
- For online access to the CPU via Ethernet PG/OP channel valid IP address parameters have to be assigned to this.

PROFIBUS/PtP interface with configurable functionality X3

9pin SubD jack:

The CPU has a PROFIBUS/PtP interface with a fix pinout. After an overall reset the interface is preset to PtP functionality without any protocol. The function of this interface may be configured during hardware configuration by setting the ‘Operating mode’ of the PROFIBUS part of the Siemens CPU (315-2AG10-0AB00 V2.6).
- PtP functionality
  - Using the PtP functionality the RS485 interface is allowed to connect via serial point-to-point connection to different source res. target systems.
  - Here the following protocols are supported: ASCII, STX/ETX, 3964R, USS and Modbus-Master (ASCII, RTU).
  - Configuration and communication happens during runtime with handling blocks.
  - To activate the PtP functionality set the PROFIBUS part to master ‘Operation mode’ without linking.
- PROFIBUS function
  - With PROFIBUS function the integrated PROFIBUS DP slave is connected to PROFIBUS via the RS485 interface.
  - To activate the PROFIBUS function set the PROFIBUS part to slave ‘Operation mode’.
4.2.3 Memory management

Memory

The CPU has an integrated memory. Information about the capacity of the memory may be found at the front of the CPU. The memory is divided into the following parts:

- Load memory 512kbyte
- Code memory (50% of the work memory)
- Data memory (50% of the work memory)
- Work memory 128kbyte
  - There is the possibility to extend the work memory to its maximum printed capacity 512kbyte by means of a MCC memory extension card.

4.2.4 Storage media slot

- As external storage medium for applications and firmware you may use a MMC storage module (Multimedia card).
- The VIPA storage media are pre-formatted with the PC format FAT16 and can be accessed via a card reader.
- After PowerON respectively an overall reset the CPU checks, if there is a storage medium with data valid for the CPU.
- Push the memory card into the slot until it snaps in leaded by a spring mechanism. This ensures contacting.
- By sliding down the sliding mechanism, a just installed memory card can be protected against drop out.
- To remove, slide the sliding mechanism up again and push the storage media against the spring pressure until it is unlocked with a click.

CAUTION!
If the media was already unlocked by the spring mechanism, with shifting the sliding mechanism, a just installed memory card can jump out of the slot!

4.2.5 Battery backup for clock and RAM

A rechargeable battery is installed on every CPU 31xS to safeguard the contents of the RAM when power is removed. This battery is also used to buffer the internal clock. The rechargeable battery is maintained by a charging circuit that receives its power from the internal power supply and that maintain the clock and RAM for a max. period of 30 days.
**CAUTION!**

Please connect the CPU at least for 24 hours to the power supply, so that the internal accumulator/battery is loaded accordingly.

After a power reset and with an empty battery the CPU starts with a BAT error and executes an overall reset. The loading procedure is not influenced by the BAT error.

The BAT error can be deleted again, if once during power cycle the time between switching on and off the power supply is at least 30sec. and the battery is fully loaded. Otherwise with a short power cycle the BAT error still exists and an overall reset is executed.

### 4.2.6 Operating mode switch

- With the operating mode switch you may switch the CPU between STOP and RUN.
- During the transition from STOP to RUN the operating mode START-UP is driven by the CPU.
- Placing the switch to MRES (Memory Reset), you request an overall reset with following load from MMC, if a project there exists.

### 4.2.7 LEDs

#### LEDs CPU

As soon as the CPU is supplied with 5V, the green PW-LED (Power) is on.

<table>
<thead>
<tr>
<th>RN (RUN)</th>
<th>ST (STOP)</th>
<th>SF (SFAIL)</th>
<th>FC (FRCE)</th>
<th>MC (MMC)</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Yellow</td>
<td>Red</td>
<td>Yellow</td>
<td>Yellow</td>
<td></td>
</tr>
</tbody>
</table>

**Boot-up after PowerON**

- ● BB* ● ● ● ● * Blinking with 10Hz: Firmware is loaded.
- ● ● ● ● ● Initialization: Phase 1
- ● ● ● ● ○ Initialization: Phase 2
- ● ● ● ○ ○ Initialization: Phase 3
- ○ ● ● ○ ○ Initialization: Phase 4

**Operation**

- ○ ● X X X CPU is in STOP state.
- BB ○ X X X CPU is in start-up state, the RUN LED blinks during operating OB100 at least for 3s.
- ● ○ ○ X X CPU is in state RUN without error.
There is a system fault. More information may be found in the diagnostics buffer of the CPU.

Variables are forced.

Access to the memory card.

* Blinking with 10Hz: Configuration is loaded.

Overall reset

- BB X X X Overall reset is requested.
- BB* X X X * Blinking with 5Hz: Overall reset is executed.

Factory reset

- Factory reset is executed.
- Factory reset finished without error.

Firmware update

- The alternate blinking indicates that there is new firmware on the memory card.
- The alternate blinking indicates that a firmware update is executed.
- Firmware update finished without error.
- * Blinking with 10Hz: Error during Firmware update.

The green L/A-LED (Link/Activity) indicates the physical connection of the Ethernet PG/OP channel to Ethernet. Irregular flashing of the L/A-LED indicates communication of the Ethernet PG/OP channel via Ethernet.

If the green S-LED (Speed) is on, the Ethernet PG/OP has a communication speed of 100MBit/s otherwise 10MBit/s.

4.3 Technical data

<table>
<thead>
<tr>
<th>Order no.</th>
<th>314-2BG03</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>CPU 314SE/DPS</td>
</tr>
<tr>
<td>SPEED-Bus</td>
<td>-</td>
</tr>
</tbody>
</table>

**Technical data power supply**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power supply (rated value)</td>
<td>DC 24 V</td>
</tr>
<tr>
<td>Power supply (permitted range)</td>
<td>DC 20.4...28.8 V</td>
</tr>
<tr>
<td>Reverse polarity protection</td>
<td>✓</td>
</tr>
<tr>
<td>Current consumption (no-load operation)</td>
<td>180 mA</td>
</tr>
<tr>
<td>Current consumption (rated value)</td>
<td>900 mA</td>
</tr>
</tbody>
</table>
## Technical data

<table>
<thead>
<tr>
<th><strong>Order no.</strong></th>
<th><strong>314-2BG03</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Inrush current</td>
<td>8 A</td>
</tr>
<tr>
<td>$I^2t$</td>
<td>0.7 A²s</td>
</tr>
<tr>
<td>Max. current drain at backplane bus</td>
<td>3 A</td>
</tr>
<tr>
<td>Power loss</td>
<td>6 W</td>
</tr>
</tbody>
</table>

### Load and working memory

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Load memory, integrated</td>
<td>512 KB</td>
</tr>
<tr>
<td>Load memory, maximum</td>
<td>512 KB</td>
</tr>
<tr>
<td>Work memory, integrated</td>
<td>128 KB</td>
</tr>
<tr>
<td>Work memory, maximal</td>
<td>512 KB</td>
</tr>
<tr>
<td>Memory divided in 50% program / 50% data</td>
<td>✓</td>
</tr>
<tr>
<td>Memory card slot</td>
<td>MMC-Card with max. 1 GB</td>
</tr>
</tbody>
</table>

### Hardware configuration

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Racks, max.</td>
<td>4</td>
</tr>
<tr>
<td>Modules per rack, max.</td>
<td>8 in multiple-, 32 in a single-rack configuration</td>
</tr>
<tr>
<td>Number of integrated DP master</td>
<td>-</td>
</tr>
<tr>
<td>Number of DP master via CP</td>
<td>4</td>
</tr>
<tr>
<td>Operable function modules</td>
<td>8</td>
</tr>
<tr>
<td>Operable communication modules PtP</td>
<td>8</td>
</tr>
<tr>
<td>Operable communication modules LAN</td>
<td>8</td>
</tr>
</tbody>
</table>

### Command processing times

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit instructions, min.</td>
<td>0.02 µs</td>
</tr>
<tr>
<td>Word instruction, min.</td>
<td>0.02 µs</td>
</tr>
<tr>
<td>Double integer arithmetic, min.</td>
<td>0.02 µs</td>
</tr>
<tr>
<td>Floating-point arithmetic, min.</td>
<td>0.12 µs</td>
</tr>
</tbody>
</table>

### Timers/Counters and their retentive characteristics

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of S7 counters</td>
<td>512</td>
</tr>
<tr>
<td>S7 counter remanence</td>
<td>adjustable 0 up to 256</td>
</tr>
<tr>
<td>S7 counter remanence adjustable</td>
<td>C0 .. C7</td>
</tr>
<tr>
<td>Number of S7 times</td>
<td>512</td>
</tr>
<tr>
<td>S7 times remanence</td>
<td>adjustable 0 up to 256</td>
</tr>
<tr>
<td>S7 times remanence adjustable</td>
<td>not retentive</td>
</tr>
</tbody>
</table>

### Data range and retentive characteristic

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of flags</td>
<td>8192 Byte</td>
</tr>
<tr>
<td>Bit memories retentive characteristic adjustable</td>
<td>adjustable 0 up to 2048</td>
</tr>
<tr>
<td>Bit memories retentive characteristic preset</td>
<td>MB0 .. MB15</td>
</tr>
<tr>
<td><strong>Order no.</strong></td>
<td>314-2BG03</td>
</tr>
<tr>
<td>----------------</td>
<td>------------</td>
</tr>
<tr>
<td>Number of data blocks</td>
<td>4095</td>
</tr>
<tr>
<td>Max. data blocks size</td>
<td>64 KB</td>
</tr>
<tr>
<td>Number range DBs</td>
<td>1 ... 4095</td>
</tr>
<tr>
<td>Max. local data size per execution level</td>
<td>1024 Byte</td>
</tr>
<tr>
<td>Max. local data size per block</td>
<td>1024 Byte</td>
</tr>
</tbody>
</table>

**Blocks**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of OBs</td>
<td>15</td>
</tr>
<tr>
<td>Maximum OB size</td>
<td>64 KB</td>
</tr>
<tr>
<td>Total number DBs, FBs, FCs</td>
<td>-</td>
</tr>
<tr>
<td>Number of FBs</td>
<td>2048</td>
</tr>
<tr>
<td>Maximum FB size</td>
<td>64 KB</td>
</tr>
<tr>
<td>Number range FBs</td>
<td>0 ... 2047</td>
</tr>
<tr>
<td>Number of FCs</td>
<td>2048</td>
</tr>
<tr>
<td>Maximum FC size</td>
<td>64 KB</td>
</tr>
<tr>
<td>Number range FCs</td>
<td>0 ... 2047</td>
</tr>
<tr>
<td>Maximum nesting depth per priority class</td>
<td>8</td>
</tr>
<tr>
<td>Maximum nesting depth additional within an error OB</td>
<td>4</td>
</tr>
</tbody>
</table>

**Time**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Real-time clock buffered</td>
<td>✓</td>
</tr>
<tr>
<td>Clock buffered period (min.)</td>
<td>6 w</td>
</tr>
<tr>
<td>Type of buffering</td>
<td>Vanadium Rechargeable Lithium Battery</td>
</tr>
<tr>
<td>Load time for 50% buffering period</td>
<td>20 h</td>
</tr>
<tr>
<td>Load time for 100% buffering period</td>
<td>48 h</td>
</tr>
<tr>
<td>Accuracy (max. deviation per day)</td>
<td>10 s</td>
</tr>
<tr>
<td>Number of operating hours counter</td>
<td>8</td>
</tr>
<tr>
<td>Clock synchronization</td>
<td>✓</td>
</tr>
<tr>
<td>Synchronization via MPI</td>
<td>Master/Slave</td>
</tr>
<tr>
<td>Synchronization via Ethernet (NTP)</td>
<td>no</td>
</tr>
</tbody>
</table>

**Address areas (I/O)**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Input I/O address area</td>
<td>2048 Byte</td>
</tr>
<tr>
<td>Output I/O address area</td>
<td>2048 Byte</td>
</tr>
<tr>
<td>Process image adjustable</td>
<td>-</td>
</tr>
<tr>
<td>Input process image preset</td>
<td>128 Byte</td>
</tr>
<tr>
<td>Output process image preset</td>
<td>128 Byte</td>
</tr>
<tr>
<td>Input process image maximal</td>
<td>128 Byte</td>
</tr>
</tbody>
</table>
## Technical data

### Order no.

<table>
<thead>
<tr>
<th>Order no.</th>
<th>314-2BG03</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output process image maximal</td>
<td>128 Byte</td>
</tr>
<tr>
<td>Digital inputs</td>
<td>16384</td>
</tr>
<tr>
<td>Digital outputs</td>
<td>16385</td>
</tr>
<tr>
<td>Digital inputs central</td>
<td>1024</td>
</tr>
<tr>
<td>Digital outputs central</td>
<td>1024</td>
</tr>
<tr>
<td>Integrated digital inputs</td>
<td>-</td>
</tr>
<tr>
<td>Integrated digital outputs</td>
<td>-</td>
</tr>
<tr>
<td>Analog inputs</td>
<td>1024</td>
</tr>
<tr>
<td>Analog outputs</td>
<td>1024</td>
</tr>
<tr>
<td>Analog inputs, central</td>
<td>256</td>
</tr>
<tr>
<td>Analog outputs, central</td>
<td>256</td>
</tr>
<tr>
<td>Integrated analog inputs</td>
<td>-</td>
</tr>
<tr>
<td>Integrated analog outputs</td>
<td>-</td>
</tr>
</tbody>
</table>

### Communication functions

<table>
<thead>
<tr>
<th>Function</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>PG/OP channel</td>
<td>✓</td>
</tr>
<tr>
<td>Global data communication</td>
<td>✓</td>
</tr>
<tr>
<td>Number of GD circuits, max.</td>
<td>8</td>
</tr>
<tr>
<td>Size of GD packets, max.</td>
<td>22 Byte</td>
</tr>
<tr>
<td>S7 basic communication</td>
<td>✓</td>
</tr>
<tr>
<td>S7 basic communication, user data per job</td>
<td>76 Byte</td>
</tr>
<tr>
<td>S7 communication</td>
<td>✓</td>
</tr>
<tr>
<td>S7 communication as server</td>
<td>✓</td>
</tr>
<tr>
<td>S7 communication as client</td>
<td>-</td>
</tr>
<tr>
<td>S7 communication, user data per job</td>
<td>160 Byte</td>
</tr>
<tr>
<td>Number of connections, max.</td>
<td>32</td>
</tr>
</tbody>
</table>

### Functionality Sub-D interfaces

<table>
<thead>
<tr>
<th>Interface</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>X2</td>
</tr>
<tr>
<td>Type of interface</td>
<td>RS485</td>
</tr>
<tr>
<td>Connector</td>
<td>Sub-D, 9-pin, female</td>
</tr>
<tr>
<td>Electrically isolated</td>
<td>-</td>
</tr>
<tr>
<td>MPI</td>
<td>✓</td>
</tr>
<tr>
<td>MP³I (MPI/RS232)</td>
<td>-</td>
</tr>
<tr>
<td>DP master</td>
<td>-</td>
</tr>
<tr>
<td>DP slave</td>
<td>-</td>
</tr>
<tr>
<td>Point-to-point interface</td>
<td>-</td>
</tr>
</tbody>
</table>
# Technical data

<table>
<thead>
<tr>
<th>Order no.</th>
<th>314-2BG03</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>X3</td>
</tr>
<tr>
<td>Type of interface</td>
<td>RS485</td>
</tr>
<tr>
<td>Connector</td>
<td>Sub-D, 9-pin, female</td>
</tr>
<tr>
<td>Electrically isolated</td>
<td>✓</td>
</tr>
<tr>
<td>MPI</td>
<td>-</td>
</tr>
<tr>
<td>MPI²I (MPI/RS232)</td>
<td>-</td>
</tr>
<tr>
<td>DP master</td>
<td>-</td>
</tr>
<tr>
<td>DP slave</td>
<td>yes</td>
</tr>
<tr>
<td>Point-to-point interface</td>
<td>✓</td>
</tr>
</tbody>
</table>

## Functionality MPI

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of connections, max.</td>
<td>32</td>
</tr>
<tr>
<td>PG/OP channel</td>
<td>✓</td>
</tr>
<tr>
<td>Routing</td>
<td>-</td>
</tr>
<tr>
<td>Global data communication</td>
<td>✓</td>
</tr>
<tr>
<td>S7 basic communication</td>
<td>✓</td>
</tr>
<tr>
<td>S7 communication</td>
<td>✓</td>
</tr>
<tr>
<td>S7 communication as server</td>
<td>✓</td>
</tr>
<tr>
<td>S7 communication as client</td>
<td>-</td>
</tr>
<tr>
<td>Transmission speed, min.</td>
<td>19.2 kbit/s</td>
</tr>
<tr>
<td>Transmission speed, max.</td>
<td>187.5 kbit/s</td>
</tr>
</tbody>
</table>

## Functionality PROFIBUS master

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>PG/OP channel</td>
<td>-</td>
</tr>
<tr>
<td>Routing</td>
<td>-</td>
</tr>
<tr>
<td>S7 basic communication</td>
<td>-</td>
</tr>
<tr>
<td>S7 communication</td>
<td>-</td>
</tr>
<tr>
<td>S7 communication as server</td>
<td>-</td>
</tr>
<tr>
<td>S7 communication as client</td>
<td>-</td>
</tr>
<tr>
<td>Activation/deactivation of DP slaves</td>
<td>-</td>
</tr>
<tr>
<td>Direct data exchange (slave-to-slave communication)</td>
<td>-</td>
</tr>
<tr>
<td>DPV1</td>
<td>-</td>
</tr>
<tr>
<td>Transmission speed, min.</td>
<td>-</td>
</tr>
<tr>
<td>Transmission speed, max.</td>
<td>-</td>
</tr>
<tr>
<td>Number of DP slaves, max.</td>
<td>-</td>
</tr>
<tr>
<td>Address range inputs, max.</td>
<td>-</td>
</tr>
<tr>
<td>Address range outputs, max.</td>
<td>-</td>
</tr>
</tbody>
</table>
## Hardware description

### Technical data

<table>
<thead>
<tr>
<th>Order no.</th>
<th>314-2BG03</th>
</tr>
</thead>
<tbody>
<tr>
<td>User data inputs per slave, max.</td>
<td>-</td>
</tr>
<tr>
<td>User data outputs per slave, max.</td>
<td>-</td>
</tr>
<tr>
<td><strong>Functionality PROFIBUS slave</strong></td>
<td></td>
</tr>
<tr>
<td>PG/OP channel</td>
<td>-</td>
</tr>
<tr>
<td>Routing</td>
<td>-</td>
</tr>
<tr>
<td>S7 communication</td>
<td>-</td>
</tr>
<tr>
<td>S7 communication as server</td>
<td>-</td>
</tr>
<tr>
<td>S7 communication as client</td>
<td>-</td>
</tr>
<tr>
<td>Direct data exchange (slave-to-slave communication)</td>
<td>-</td>
</tr>
<tr>
<td>DPV1</td>
<td>✓</td>
</tr>
<tr>
<td>Transmission speed, min.</td>
<td>9.6 kbit/s</td>
</tr>
<tr>
<td>Transmission speed, max.</td>
<td>12 Mbit/s</td>
</tr>
<tr>
<td>Automatic detection of transmission speed</td>
<td>-</td>
</tr>
<tr>
<td>Transfer memory inputs, max.</td>
<td>244 Byte</td>
</tr>
<tr>
<td>Transfer memory outputs, max.</td>
<td>244 Byte</td>
</tr>
<tr>
<td>Address areas, max.</td>
<td>32</td>
</tr>
<tr>
<td>User data per address area, max.</td>
<td>32 Byte</td>
</tr>
<tr>
<td><strong>Point-to-point communication</strong></td>
<td></td>
</tr>
<tr>
<td>PtP communication</td>
<td>✓</td>
</tr>
<tr>
<td>Interface isolated</td>
<td>✓</td>
</tr>
<tr>
<td>RS232 interface</td>
<td>-</td>
</tr>
<tr>
<td>RS422 interface</td>
<td>-</td>
</tr>
<tr>
<td>RS485 interface</td>
<td>✓</td>
</tr>
<tr>
<td>Connector</td>
<td>Sub-D, 9-pin, female</td>
</tr>
<tr>
<td>Transmission speed, min.</td>
<td>150 bit/s</td>
</tr>
<tr>
<td>Transmission speed, max.</td>
<td>115.5 kbit/s</td>
</tr>
<tr>
<td>Cable length, max.</td>
<td>500 m</td>
</tr>
<tr>
<td><strong>Point-to-point protocol</strong></td>
<td></td>
</tr>
<tr>
<td>ASCII protocol</td>
<td>✓</td>
</tr>
<tr>
<td>STX/ETX protocol</td>
<td>✓</td>
</tr>
<tr>
<td>3964(R) protocol</td>
<td>✓</td>
</tr>
<tr>
<td>RK512 protocol</td>
<td>-</td>
</tr>
<tr>
<td>USS master protocol</td>
<td>✓</td>
</tr>
<tr>
<td>Modbus master protocol</td>
<td>✓</td>
</tr>
<tr>
<td>Modbus slave protocol</td>
<td>-</td>
</tr>
</tbody>
</table>
**Order no.** | 314-2BG03
--- | ---
Special protocols | -

**Functionality RJ45 interfaces**

| Type | X4 |
| Type of interface | Ethernet 10/100 MBit |
| Connector | RJ45 |
| Electrically isolated | ✓ |
| PG/OP channel | ✓ |
| Number of connections, max. | 4 |
| Productive connections | - |

**Housing**

| Material | PPE |
| Mounting | Rail System 300 |

**Mechanical data**

| Dimensions (WxHxD) | 40 mm x 125 mm x 120 mm |
| Weight | 235 g |

**Environmental conditions**

| Operating temperature | 0 °C to 60 °C |
| Storage temperature | -25 °C to 70 °C |

**Certifications**

| UL508 certification | yes |
5 Deployment CPU 314-2BG03

5.1 Assembly

Information about assembly and cabling: § Chapter 3 ‘Assembly and installation guidelines’ on page 16

5.2 Start-up behavior

Turn on power supply
After the power supply has been switched on, the CPU changes to the operating mode the operating mode lever shows.

Default boot procedure, as delivered
When the CPU is delivered it has been reset. After a STOP → RUN transition the CPU switches to RUN without program.

Boot procedure with valid configuration in the CPU
The CPU switches to RUN with the program stored in the battery buffered RAM.

Boot procedure with empty battery
- The accumulator/battery is automatically loaded via the integrated power supply and guarantees a buffer for max. 30 days. If this time is exceeded, the battery may be totally discharged. This means that the battery buffered RAM is deleted.
- In this state, the CPU executes an overall reset. If a MMC is plugged, program code and data blocks are transferred from the MMC into the work memory of the CPU. If no MMC is plugged, the CPU transfers permanent stored "protected" blocks into the work memory if available.
- Depending on the position of the operating mode switch, the CPU switches to RUN, if OB81 exists, res. remains in STOP. This event is stored in the diagnostic buffer as: "Start overall reset automatically (unbuffered PowerON)".

CAUTION!
After a power reset and with an empty battery the CPU starts with a BAT error and executes an overall reset. The BAT error can be deleted again, if once during power cycle the time between switching on and off the power supply is at least 30 sec. and the battery is fully loaded. Otherwise with a short power cycle the BAT error still exists and an overall reset is executed.
5.3 Addressing

5.3.1 Overview

To provide specific addressing of the installed peripheral modules, certain addresses must be allocated in the CPU. At the start-up of the CPU, this assigns automatically peripheral addresses for digital in-/output modules starting with 0 and ascending depending on the slot location. If no hardware project engineering is available, the CPU stores at the addressing analog modules to even addresses starting with 256.

5.3.2 Addressing Backplane bus I/O devices

The CPU 314-2BG03 provides an I/O area (address 0 ... 2047) and a process image of the in- and outputs (each address 0 ... 127). The process image stores the signal states of the lower address (0 ... 127) additionally in a separate memory area.

The process image is divided into two parts:
- process image to the inputs (PII)
- process image to the outputs (PIQ)

The process image is updated automatically when a cycle has been completed.

Max. number of pluggable modules

Maximally 8 modules per row may be configured by the CPU 314-2BG03.

For the project engineering of more than 8 modules you may use line interface connections. For this you set in the hardware configurator the module IM 360 from the hardware catalog to slot 3 of your 1. profile rail. Now you may extend your system with up to 3 profile rails by starting each with an IM 361 from Siemens at slot 3. Considering the max total current with the CPU 314-2BG03 from VIPA up to 32 modules may be arranged in a row. Here the installation of the line connections IM 360/361 from Siemens is not required.

Define addresses by hardware configuration

You may access the modules with read res. write accesses to the peripheral bytes or the process image.

To define addresses a hardware configuration may be used. For this, click on the properties of the according module and set the wanted address.
Automatic addressing

If you do not like to use a hardware configuration, an automatic addressing comes into force. At the automatic address allocation DIOs occupy depending on the slot location always 4 byte and AIOs, FMs, CPs always 16 byte at the bus. Depending on the slot location the start address from where on the according module is stored in the address range is calculated with the following formulas:

- DIOs: Start address = 4×(slot -1)
- AIOs, FMs, CPs: Start address = 16×(slot -1)+256

The following sample shows the functionality of the automatic address allocation:

Example for automatic address allocation

5.4 Hardware configuration - CPU

Precondition

The configuration of the CPU takes place at the Siemens ‘hardware configurator’. The hardware configurator is part of the Siemens SIMATIC Manager. It serves for project engineering. The modules, which may be configured here are listed in the hardware catalog. If necessary you have to update the hardware catalog with ‘Options ➔ Update Catalog’.
For project engineering a thorough knowledge of the Siemens SIMATIC Manager and the Siemens hardware configurator is required.

**Please consider that this SPEED7-CPU has 4 ACCUs. After an arithmetic operation (+I, -I, *I, /I, +D, -D, *D, /D, MOD, +R, -R, *R, /R) the content of ACCU 3 and ACCU 4 is loaded into ACCU 3 and 2. This may cause conflicts in applications that presume an unmodified ACCU 2.**

For more information may be found in the manual "VIPA Operation list SPEED7" at "Differences between SPEED7 and 300V programming".

### Proceeding

<table>
<thead>
<tr>
<th>Slot</th>
<th>Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>CPU 315-2DP</td>
</tr>
<tr>
<td>X2</td>
<td>DP</td>
</tr>
<tr>
<td>3</td>
<td></td>
</tr>
</tbody>
</table>

In the Siemens SIMATIC Manager the following steps should be executed:

1. Start the Siemens hardware configurator with a new project.
2. Insert a profile rail from the hardware catalog.
3. Place at ‘Slot’ number 2 the CPU 315-2DP (6ES7 315-2AG10-0AB0/V2.6).
4. Configure the integrated PROFIBUS DP slave by means of the PROFIBUS part of the Siemens CPU 315-2AG10 switched to slave `Operation mode`. See Chapter 7 ‘Deployment PROFIBUS communication’ on page 104.

### 5.5 Hardware configuration - I/O modules

#### Hardware configuration of the modules

After the hardware configuration place the System 300 modules in the plugged sequence starting with slot 4.
**Parametrization**

For parametrization double-click during the project engineering at the slot overview on the module you want to parameterize. In the appearing dialog window you may set the wanted parameters. By using the SFCs 55, 56 and 57 you may alter and transfer parameters for wanted modules during runtime. For this you have to store the module specific parameters in so called "record sets". More detailed information about the structure of the record sets is to find in the according module description.

**Bus extension with IM 360 and IM 361**

For the project engineering of more than 8 modules you may use line interface connections. For this you set in the hardware configurator the module IM 360 from the hardware catalog to slot 3 of your 1. profile rail. Now you may extend your system with up to 3 profile rails by starting each with an IM 361 from Siemens at slot 3. Considering the max. total current with the VIPA SPEED7 CPUs up to 32 modules may be arranged in a row. Here the installation of the line connections IM 360/361 from Siemens is not required.

### 5.6 Hardware configuration - Ethernet PG/OP channel

**Overview**

The CPU 314-2BG03 has an integrated Ethernet PG/OP channel. This channel allows you to program and remote control your CPU. The PG/OP channel also gives you access to the internal web page that contains information about firmware version, connected I/O devices, current cycle times etc. With the first start-up respectively after an overall reset the Ethernet PG/OP channel does not have any IP address. For online access to the CPU via Ethernet PG/OP channel valid IP address parameters have to be assigned to this by means of the Siemens SIMATIC Manager. This is called "initialization".

**Assembly and commissioning**

1. **Install your System 300S with your CPU.**
2. **Wire the system by connecting cables for voltage supply and signals.**
3. **Connect the Ethernet jack of the Ethernet PG/OP channel to Ethernet**
4. **Switch on the power supply.**

   - After a short boot time the CP is ready for communication. He possibly has no IP address data and requires an initialization.
"Initialization" via PLC functions

The initialization via PLC functions takes place with the following proceeding:

1. Start the Siemens SIMATIC Manager and set via ‘Options \ Set PG/PC interface’ the access path to ‘TCP/IP -> Network card ....’.
2. Open with ‘PLC \ Edit Ethernet Node n’ the dialog window with the same name.
3. To get the stations and their MAC address, use the [Browse] button or type in the MAC Address. The Mac address may be found at the 1. label beneath the front flap of the CPU.
4. Choose if necessary the known MAC address of the list of found stations.
5. Either type in the IP configuration like IP address, subnet mask and gateway.
6. Confirm with [Assign IP configuration].

Direct after the assignment the Ethernet PG/OP channel may be reached online by these address data. The value remains as long as it is reassigned, it is overwritten by a hardware configuration or an factory reset is executed.

Assign IP address parameters

You get valid IP address parameters from your system administrator. The assignment of the IP address data happens online in the Siemens SIMATIC Manager starting with version V 5.3 & SP3 with the following proceeding:

1. Start the Siemens SIMATIC Manager and set via ‘Options \ Set PG/PC interface’ the access path to ‘TCP/IP -> Network card ....’.
2. Open with ‘PLC \ Edit Ethernet Node n’ the dialog window with the same name.
3. To get the stations and their MAC address, use the [Browse] button or type in the MAC Address. The Mac address may be found at the 1. label beneath the front flap of the CPU.
4. Choose if necessary the known MAC address of the list of found stations.
5. Either type in the IP configuration like IP address, subnet mask and gateway.
6. Confirm with [Assign IP configuration].

Direct after the assignment the Ethernet PG/OP channel may be reached online by these address data. The value remains as long as it is reassigned, it is overwritten by a hardware configuration or an factory reset is executed.

Take IP address parameters in project

1. Open the Siemens hardware configurator und configure the Siemens CPU 315-2DP (315-2AG10-0AB00 V2.6).
2. Configure the modules at the standard bus.
3. For the Ethernet PG/OP channel you have to configure a Siemens CP 343-1 (SIMATIC 300 \ CP 300 \ Industrial Ethernet \CP 343-1 \ 6GK7 343-1EX11 0XE0) always below the really plugged modules.
4. Open the property window via double-click on the CP 343-1EX11 and enter for the CP at ‘Properties’ the IP address data, which you have assigned before.
5. Assign the CP to a ‘Subnet’. Without assignment the IP address data are not used!

6. Transfer your project.

5.7 Hardware configuration - Communication

The hardware configuration of PROFIBUS and PtP is described at the following pages:

- PROFIBUS DP
  - Slave operation: "Chapter 7.2 ‘Deployment as PROFIBUS DP slave’ on page 105"

- PtP
  - PtP: "Chapter 6.3 ‘Deployment of RS485 interface for PtP’ on page 80"

5.8 Setting CPU parameters

5.8.1 Parametrization via Siemens CPU

Since the CPU is to be configured as Siemens CPU 315-2DP (CPU 315-2AG10 V2.6) in the Siemens hardware configurator, the standard parameters of the VIPA CPU may be set with “Object properties” of the CPU 315-2DP during hardware configuration. Via a double-click on the CPU 315-2DP the parameter window of the CPU may be accessed. Using the registers you get access to every standard parameter of the CPU.
5.8.2 Parameters CPU

The CPU does not evaluate each parameter, which may be set at the hardware configuration. The following parameters are supported by the CPU at this time:

**Supported parameters**

**General**
- **Short description:** The short description of the Siemens CPU 315-2AG10 is CPU 315-2DP.
- **Order No. / Firmware:** Order number and firmware are identical to the details in the "hardware catalog" window.
- **Name:** The Name field provides the short description of the CPU. If you change the name the new name appears in the Siemens SIMATIC Manager.
- **Plant designation:** Here is the possibility to specify a plant designation for the CPU. This plant designation identifies parts of the plant according to their function. Its structure is hierarchic according to IEC 1346-1.
- **Comment:** In this field information about the module may be entered.

**Startup**
- **Startup when expected/actual configuration differs:** If the checkbox for ‘Startup when expected/actual configuration differ’ is deselected and at least one module is not located at its configured slot or if another type of module is inserted there instead, then the CPU does not switch to RUN mode and remains in STOP mode. If the checkbox for ‘Startup when expected/actual configuration differ’ is selected, then the CPU starts even if there are modules not located in their configured slots of if another type of module is inserted there instead, such as during an initial system start-up.
- **Monitoring time for ready message by modules [100ms]:** This operation specifies the maximum time for the ready message of every configured module after PowerON. If the modules do not send a ready message to the CPU by the time the monitoring time has expired, the actual configuration becomes unequal to the preset configuration. Monitoring time for ready message by modules [100ms]
- **Transfer of parameters to modules [100ms]:** The maximum time for the transfer of parameters to parametrizable modules. If not every module has been assigned parameters by the time this monitoring time has expired, the actual configuration becomes unequal to the preset configuration.

**Cycle/Clock memory**
- **Update OB1 process image cyclically:** This parameter is not relevant.
- **Scan cycle monitoring time:** Here the scan cycle monitoring time in milliseconds may be set. If the scan cycle time exceeds the scan cycle monitoring time, the CPU enters the STOP mode. Possible reasons for exceeding the time are:
  - Communication processes
  - a series of interrupt events
  - an error in the CPU program
- **Minimum scan cycle time:** This parameter is not relevant.
- **Scan cycle load from Communication:** This parameter is not relevant.
- Size of the process image input/output area: Here the size of the process image max. 2048 for the input/output periphery may be fixed.
- OB85 call up at I/O access error: The preset reaction of the CPU may be changed to an I/O access error that occurs during the update of the process image by the system. The VIPA CPU is preset such that OB 85 is not called if an I/O access error occurs and no entry is made in the diagnostic buffer either.
- Clock memory: Activate the check box if you want to use clock memory and enter the number of the memory byte. 
  
  The selected memory byte cannot be used for temporary data storage.

### Retentive Memory
- Number of Memory bytes from MB0: Enter the number of retentive memory bytes from memory byte 0 onwards.
- Number of S7 Timers from T0: Enter the number of retentive S7 timers from T0 onwards. Each S7 timer occupies 2 bytes.
- Number of S7 Counters from C0: Enter the number of retentive S7 counter from C0 onwards.
- Areas: This parameter is not supported.

### Interrupts
- Priority: Here the priorities are displayed, according to which the hardware interrupt OBs are processed (hardware interrupt, time-delay interrupt, async. error interrupts).

### Time-of-day interrupts
- Priority: Here the priorities may be specified according to which the time-of-day interrupt is processed. With priority "0" the corresponding OB is deactivated.
- Active: Activate the check box of the time-of-day interrupt OBs if these are to be automatically started on complete restart.
- Execution: Select how often the interrupts are to be triggered. Intervals ranging from every minute to yearly are available. The intervals apply to the settings made for start date and time.
- Start date/time: Enter date and time of the first execution of the time-of-day interrupt.
- Process image partition: This parameter is not supported.

### Cyclic interrupts
- Priority: Here the priorities may be specified according to which the corresponding cyclic interrupt is processed. With priority "0" the corresponding interrupt is deactivated.
- Execution: Enter the time intervals in ms, in which the watchdog interrupt OBs should be processed. The start time for the clock is when the operating mode switch is moved from STOP to RUN.
- Phase offset: Enter the delay time in ms for current execution for the watch dog interrupt. This should be performed if several watchdog interrupts are enabled. Phase offset allows to distribute processing time for watchdog interrupts across the cycle.
- Process image partition: This parameter is not supported.
### Protection
- Level of protection: Here 1 of 3 protection levels may be set to protect the CPU from unauthorized access.
  - **Protection level 1 (default setting):**
    - No password adjustable, no restrictions
  - **Protection level 2 with password:**
    - Authorized users: read and write access
    - Unauthorized user: read access only
  - **Protection level 3:**
    - Authorized users: read and write access
    - Unauthorized user: no read and write access

### 5.9 Project transfer

#### Overview
There are the following possibilities for project transfer into the CPU:
- Transfer via MPI
- Transfer via Ethernet
- Transfer via MMC

#### 5.9.1 Transfer via MPI

**General**
For transfer via MPI there is the following interface:
- X2: MPI interface

**Net structure**
The structure of a MPI net is electrically identical with the structure of a PROFIBUS net. This means the same rules are valid and you use the same components for the build-up. The single participants are connected with each other via bus interface plugs and PROFIBUS cables. Please consider with the CPU 314-2BG03 that the total extension of the MPI net does not exceed 50m. Per default the MPI net runs with 187.5kbaud. VIPA CPUs are delivered with MPI address 2.

**MPI programming cable**
The MPI programming cables are available at VIPA in different variants. The cables provide a RS232 res. USB plug for the PC and a bus enabled RS485 plug for the CPU. Due to the RS485 connection you may plug the MPI programming cables directly to an already plugged plug on the RS485 jack. Every bus participant identifies itself at the bus with an unique address, in the course of the address 0 is reserved for programming devices.

**Terminating resistor**
A cable has to be terminated with its surge impedance. For this you switch on the terminating resistor at the first and the last participant of a network or a segment. Please make sure that the participants with the activated terminating resistors are always power supplied. Otherwise it may cause interferences on the bus.
1. Connect your PC to the MPI jack of your CPU via a MPI pro-
   gramming cable.
2. Load your project in the SIMATIC Manager from Siemens.
3. Choose in the menu ‘Options ➔ Set PG/PC interface’.
4. Select in the according list the "PC Adapter (MPI)", if appropriate
   you have to add it first, then click on [Properties].
5. Set in the register MPI the transfer parameters of your MPI net
   and type a valid address.
6. Switch to the register Local connection.
7. Set the COM port of the PCs and the transfer rate 38400Baud
   for the MPI programming cable from VIPA.
8. Via ‘PLC ➔ Load to module’ via MPI to the CPU and save it on
   a MMC via ‘PLC ➔ Copy RAM to ROM’ if one is plugged.

5.9.2 Transfer via Ethernet

For transfer via Ethernet the CPU has the following interface:
- X4: Ethernet PG/OP channel

Initialization
So that you may access the Ethernet PG/OP channel you have to
assign IP address parameters by means of the "initialization".
☞ Chapter 5.6 ‘Hardware configuration - Ethernet PG/OP channel’
on page 40

Transfer
1. For the transfer, connect, if not already done, the appropriate
   Ethernet port to your Ethernet.
2. Open your project with the Siemens SIMATIC Manager.
3. Set via ‘Options ➔ Set PG/PC Interface’ the access path to
   "TCP/IP → Network card .... ".
4. Click to ‘PLC ➔ Download’ Download → the dialog "Select
   target module" is opened. Select your target module and enter
   the IP address parameters of the Ethernet PG/OP channel for
   connection. Provided that no new hardware configuration is
   transferred to the CPU, the entered Ethernet connection is per-
   manently stored in the project as transfer channel.
5. With [OK] the transfer is started.
System dependent you get a message that the projected system differs from target system. This message may be accepted by [OK].

→ Your project is transferred and may be executed in the CPU after transfer.

5.9.3 Transfer via MMC

The MMC (Memory Card) serves as external transfer and storage medium. There may be stored several projects and sub-directories on a MMC storage module. Please regard that your current project is stored in the root directory and has one of the following file names:

- S7PROG.WLD
- AUTOLOAD.WLD

With ‘File ➔ Memory Card File ➔ New’ in the Siemens SIMATIC Manager a new wld file may be created. After the creation copy the blocks from the project blocks folder and the System data into the wld file.

Transfer MMC ➔ CPU

The transfer of the application program from the MMC into the CPU takes place depending on the file name after an overall reset or PowerON.

- S7PROG.WLD is read from the MMC after overall reset.
- AUTOLOAD.WLD is read after PowerON from the MMC.

The blinking of the MC LED of the CPU marks the active transfer. Please regard that your user memory serves for enough space, otherwise your user program is not completely loaded and the SF LED gets on.

Transfer CPU ➔ MMC

When the MMC has been installed, the write command stores the content of the battery buffered RAM as S7PROG.WLD on the MMC.

The write command is controlled by means of the block area of the Siemens SIMATIC Manager ‘PLC ➔ Copy RAM to ROM’. During the write process the MC LED of the CPU is blinking. When the LED expires the write process is finished.

If this project is to be loaded automatically from the MMC with PowerON, you have to rename this on the MMC to AUTOLOAD.WLD.

Transfer control

After a MMC access, an ID is written into the diagnostic buffer of the CPU. To monitor the diagnosis entries, you select ‘PLC ➔ Module Information’ in the Siemens SIMATIC Manager. Via the register “Diagnostic Buffer” you reach the diagnosis window.

Information about the event IDs ➔ Chapter 5.19 ‘VIPA specific diagnostic entries’ on page 62.
5.10 Access to the internal Web page

**Access to the web page**
The Ethernet PG/OP channel provides a web page that you may access via an Internet browser by its IP address. The web page contains information about firmware versions, current cycle times etc. The current content of the web page is stored on MMC by means of the MMC-Cmd WEBPAGE. Chapter 5.18 'MMC-Cmd - Auto commands' on page 60

**Requirements**
A PG/OP channel connection should be established between PC with Internet browser and CPU 314-2BG03. This may be tested by Ping to the IP address of the PG/OP channel.

**Web page**
The access takes place via the IP address of the Ethernet PG/OP channel. The web page only serves for information output. The monitored values are not alterable.

**CPU with Ethernet-PG/OP**

<table>
<thead>
<tr>
<th>Slot 100</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>VIPA 314-2BG03 V.... Px000093.pkg, SERIALNUMBER 000638</strong></td>
</tr>
<tr>
<td><strong>SUPPORTDATA</strong></td>
</tr>
<tr>
<td>PRODUCT V2060, HARDWARE V0111, 5679B-V11, Hx000049.100, Bx000152 V5060, Ax000055 V1090, Ax000056 V0200, fx000007.wld V1120,</td>
</tr>
<tr>
<td><strong>Memorysizes (Bytes): LoadMem : 524288, WorkMem-Code : 65536, WorkMemData : 65536</strong></td>
</tr>
<tr>
<td><strong>OnBoardEthernet : MacAddress : 0020D50144C1, IP-Address : 172.20.120.62, SubnetMask : 255.255.255.0, Gateway : 172.20.120.62</strong></td>
</tr>
<tr>
<td><strong>Cpu state : Run</strong></td>
</tr>
<tr>
<td><strong>FunctionRS485 X2/COM1: MPI</strong></td>
</tr>
<tr>
<td><strong>FunctionRS485 X3/COM2: DPS</strong></td>
</tr>
<tr>
<td><strong>Cycletime [microseconds] : min=0 cur=770 ave=750 max=878</strong></td>
</tr>
<tr>
<td><strong>MCC-Trial-Time: 70:23</strong></td>
</tr>
</tbody>
</table>

**Order no., firmware vers., package, serial no.**

**Information for support**

**Information about memory configuration, load memory, work memory (code/data)**

**Ethernet PG/OP: Addresses**

**CPU state**

**Operating mode RS485:**
- MPI: MPI operation
- DPS: DP slave operation
- PtP: point to point operation

**CPU cycle time:**
- min = minimal
- cur = current
- max = maximal

**Remaining time in hh:mm for deactivation of the expansion memory if MCC is removed.**
Slot 100

ArmLoad [percent] : cur=67, max=70
PowerCycleHxRetries : 29, 0, 0, 0, 0

Information for support

Standard Bus

<table>
<thead>
<tr>
<th>Standard Bus</th>
<th>Modules at the standard bus</th>
</tr>
</thead>
<tbody>
<tr>
<td>BaudRate Read Mode1, BaudRate Write Mode1</td>
<td>IM interface if exists</td>
</tr>
<tr>
<td>Line 1: ModuleType 94F9:IM36x</td>
<td>Rack no. / slot</td>
</tr>
<tr>
<td>Rack 0 /Slot 4</td>
<td></td>
</tr>
<tr>
<td>ModuleType:9FC3: Digital Input 32</td>
<td>Type of module</td>
</tr>
<tr>
<td>Baseaddress Input 0</td>
<td>Configured base address</td>
</tr>
<tr>
<td></td>
<td>if exists firmware no. and package</td>
</tr>
<tr>
<td>Rack 0 /Slot 5 ...</td>
<td>Rack no. / slot</td>
</tr>
<tr>
<td>...</td>
<td></td>
</tr>
<tr>
<td>Line 2: ModuleType A4FE:IM36x</td>
<td>IM interface if exists</td>
</tr>
<tr>
<td>Rack 1 /Slot 4</td>
<td></td>
</tr>
<tr>
<td>ModuleType:9FC3: Digital Input 32</td>
<td>Type of module</td>
</tr>
<tr>
<td>Baseaddress Input 0</td>
<td>Configured base address</td>
</tr>
<tr>
<td></td>
<td>if exists firmware no. and package</td>
</tr>
<tr>
<td>Rack 1 /Slot 5 ...</td>
<td>Rack no. / slot</td>
</tr>
</tbody>
</table>

5.11 Operating modes

5.11.1 Overview

The CPU can be in one of 4 operating modes:
- Operating mode STOP
- Operating mode START-UP
- Operating mode RUN
- Operating mode HALT

Certain conditions in the operating modes START-UP and RUN require a specific reaction from the system program. In this case the application interface is often provided by a call to an organization block that was included specifically for this event.

Operating mode STOP

- The application program is not processed.
- If there has been a processing before, the values of counters, timers, flags and the process image are retained during the transition to the STOP mode.
- Outputs are inhibited, i.e. all digital outputs are disabled.
- RUN-LED off
- STOP-LED on
Operating mode START-UP

- During the transition from STOP to RUN a call is issued to the start-up organization block OB 100. The processing time for this OB is not monitored. The START-UP OB may issue calls to other blocks.
- All digital outputs are disabled during the START-UP, i.e. outputs are inhibited.
- RUN-LED blinks as soon as the OB 100 is operated and for at least 3s, even if the start-up time is shorter or the CPU gets to STOP due to an error. This indicates the start-up.
- STOP-LED off

When the CPU has completed the START-UP OB, it assumes the operating mode RUN.

Operating mode RUN

- The application program in OB 1 is processed in a cycle. Under the control of alarms other program sections can be included in the cycle.
- All timers and counters being started by the program are active and the process image is updated with every cycle.
- The BASP-signal (outputs inhibited) is deactivated, i.e. all digital outputs are enabled.
- RUN-LED on
- STOP-LED off

Operating mode HOLD

The CPU offers up to 3 breakpoints to be defined for program diagnosis. Setting and deletion of breakpoints happens in your programming environment. As soon as a breakpoint is reached, you may process your program step by step.

Precondition

For the usage of breakpoints, the following preconditions have to be fulfilled:

- Testing in single step mode is possible with STL. If necessary switch the view via ‘View ➔ STL’ to STL.
- The block must be opened online and must not be protected.

Approach for working with breakpoints

1. Activate ‘View ➔ Breakpoint Bar’.
2. Set the cursor to the command line where you want to insert a breakpoint.
3. Set the breakpoint with ‘Debug ➔ Set Breakpoint’.
   - The according command line is marked with a circle.
4. To activate the breakpoint click on ‘Debug ➔ Breakpoints Active’.
   - The circle is changed to a filled circle.
5. Bring your CPU into RUN.
   - When the program reaches the breakpoint, your CPU switches to the state HOLD, the breakpoint is marked with an arrow and the register contents are monitored.
6. Now you may execute the program code step by step via ‘Debug ➔ Execute Next Statement’ or run the program until the next breakpoint via ‘Debug ➔ Resume’.
7. Delete (all) breakpoints with the option ‘Debug
   \(\Rightarrow\) Delete All Breakpoints’.

**Behavior in operating state HOLD**

- The RUN-LED blinks and the STOP-LED is on.
- The execution of the code is stopped. No level is further executed.
- All times are frozen.
- The real-time clock runs is just running.
- The outputs were disabled (BASP is activated).
- Configured CP connections remain exist.

---

**The usage of breakpoints is always possible. Switching to the operating mode test operation is not necessary.**

*With more than 2 breakpoints, a single step execution is not possible.*

### 5.11.2 Function security

The CPUs include security mechanisms like a Watchdog (100ms) and a parametrizable cycle time surveillance (parametrizable min. 1ms) that stop res. execute a RESET at the CPU in case of an error and set it into a defined STOP state. The VIPA CPUs are developed function secure and have the following system properties:

<table>
<thead>
<tr>
<th>Event</th>
<th>concerns</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>RUN → STOP</td>
<td>general</td>
<td>BASP (Befehls-Ausgabe-Sperre, i.e. command output lock) is set.</td>
</tr>
<tr>
<td></td>
<td>central digital outputs</td>
<td>The outputs are disabled.</td>
</tr>
<tr>
<td></td>
<td>central analog outputs</td>
<td>The outputs are disabled.</td>
</tr>
<tr>
<td></td>
<td>- Voltage outputs issue 0V</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Current outputs 0...20mA issue 0mA</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Current outputs 4...20mA issue 4mA</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If configured also substitute values may be issued.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>decentral outputs</td>
<td>Same behavior as the central digital/analog outputs.</td>
</tr>
<tr>
<td></td>
<td>decentral inputs</td>
<td>The inputs are cyclically be read by the decentralized station and the recent values are put at disposal.</td>
</tr>
<tr>
<td>STOP → RUN res. PowerON</td>
<td>general</td>
<td>First the PII is deleted, then OB 100 is called. After the execution of the OB, the BASP is reset and the cycle starts with: Delete PIO (\Rightarrow) Read PII (\Rightarrow) OB 1.</td>
</tr>
<tr>
<td></td>
<td>decentral inputs</td>
<td>The inputs are once be read by the decentralized station and the recent values are put at disposal.</td>
</tr>
<tr>
<td>Event</td>
<td>concerns</td>
<td>Effect</td>
</tr>
<tr>
<td>--------</td>
<td>----------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>RUN</td>
<td>general</td>
<td>The program execution happens cyclically and can therefore be foreseen: Read PII (\rightarrow) OB 1 (\rightarrow) Write PIO.</td>
</tr>
</tbody>
</table>

PII: Process image inputs, PIO: Process image outputs

## 5.12 Overall reset

### Overview

During the overall reset the entire user memory is erased. Data located in the memory card is not affected. You have 2 options to initiate an overall reset:

- initiate the overall reset by means of the operating mode switch
- initiate the overall reset by means of the Siemens SIMATIC Manager

> You should always issue an overall reset to your CPU before loading an application program into your CPU to ensure that all blocks have been cleared from the CPU.

### Overall reset by means of the operating mode switch

#### Precondition

The operating mode of the CPU is to be switched to STOP. For this switch the operating mode switch of the CPU to “STOP”.

⇒ The STOP-LED is on.

#### Overall reset

1. Switch the operating mode switch to MRES position for about 3 seconds.

⇒ The STOP-LED changes from blinking to permanently on.

2. Place the operating mode switch in the position STOP and switch it to MRES and quickly back to STOP within a period of less than 3 seconds.

⇒ The STOP-LED blinks (overall reset procedure).
3. The overall reset has been completed when the STOP-LED is on permanently.

⇒ The STOP-LED is on. The following figure illustrates the above procedure:

![Overall reset procedure diagram]

Overall reset by means of the Siemens SIMATIC Manager

- **Precondition** The operating mode of the CPU is to be switched to STOP. You may place the CPU in STOP by the menu command ‘PLC ➔ Operating mode’.
- **Overall reset**: You may request the overall reset by means of the menu command ‘PLC ➔ Clean/Reset’. In the dialog window you may place your CPU in STOP state and start the overall reset if this has not been done as yet. The STOP-LED blinks during the overall reset procedure. When the STOP-LED is on permanently the overall reset procedure has been completed.

Automatic reload

If there is a project S7PROG.WLD on the MMC, the CPU attempts to reload this project from MMC.

⇒ The MC LED is on. When the reload has been completed the LED expires. The operating mode of the CPU will be STOP respectively RUN, depending on the position of the operating mode switch.

Reset to factory setting

The *Reset to factory setting* deletes completely the internal RAM of the CPU and resets this to delivery state. Please regard that the MPI address is also set back to default 2! *Chapter 5.14 ‘Reset to factory setting’ on page 56*
5.13 Firmware update

Overview

- There is the opportunity to execute a firmware update for the CPU and its components via MMC. For this an accordingly prepared MMC must be in the CPU during the startup.
- So a firmware file can be recognized and assigned with startup, a pkg file name is reserved for each updateable component an hardware release, which begins with "px" and differs in a number with six digits. The pkg file name of every updateable component may be found at a label right down the front flap of the module.
- After PowerON and CPU STOP the CPU checks if there is a *.pkg file on the MMC. If this firmware version is different to the existing firmware version, this is indicated by blinking of the LEDs and the firmware may be installed by an update request.

Latest firmware at www.vipa.com

The latest firmware versions are to be found in the service area at www.vipa.com. For example the following files are necessary for the firmware update of the CPU 314-2BG03 and its components with hardware release 1:

- 314-2BG03, Hardware release 1: Px000093.pkg

CAUTION!
When installing a new firmware you have to be extremely careful. Under certain circumstances you may destroy the CPU, for example if the voltage supply is interrupted during transfer or if the firmware file is defective. In this case, please call the VIPA-Hotline!

Please regard that the version of the update firmware has to be different from the existing firmware otherwise no update is executed.

Display the Firmware version of the SPEED7 system via Web Site

The CPU has an integrated website that monitors information about firmware version of the SPEED7 components. The Ethernet PG/OP channel provides the access to this web site. The CPU has an integrated website that monitors information about firmware version of the SPEED7 components. The Ethernet PG/OP channel provides the access to this web site. "PLC ➔ Assign Ethernet Address". After that you may access the PG/OP channel with a web browser via the IP address of the project engineering. "Chapter 5.10 ‘Access to the internal Web page’ on page 48"
Load firmware and transfer it to MMC

- Go to www.vipa.com
- Click on ‘Service ➔ Download ➔ Firmware’.
- Navigate via ‘System 300S ➔ CPU’ to your CPU and download the zip file to your PC.
- Extract the zip file and copy the extracted pkg files to your MMC.

Transfer firmware from MMC into CPU

1. Switch the operating mode switch of your CPU in position STOP. Turn off the voltage supply. Plug the MMC with the firmware files into the CPU. Please take care of the correct plug-in direction of the MMC. Turn on the voltage supply.

2. After a short boot-up time, the alternate blinking of the LEDs SF and FC shows that at least a more current firmware file was found on the MMC.

3. You start the transfer of the firmware as soon as you tip the operating mode switch downwards to MRES within 10s.

4. During the update process, the LEDs SF and FC are alternately blinking and MC LED is on. This may last several minutes.

5. The update is successful finished when the LEDs PW, ST, SF, FC and MC are on. If they are blinking fast, an error occurred.

6. Turn Power OFF and ON. Now it is checked by the CPU, whether further current firmware versions are available at the MMC. If so, again the LEDs SF and FC flash after a short start-up period. Continue with point 3.

   - If the LEDs do not flash, the firmware update is ready. Now a factory reset should be executed (see next page). After that the CPU is ready for duty.
5.14 Reset to factory setting

**Proceeding**

With the following proceeding the internal RAM of the CPU is completely deleted and the CPU is reset to delivery state.

Please note that here also the IP address of the Ethernet PG/OP channel is set to 0.0.0.0 and the MPI address is reset to the address 2!

A reset to factory setting may also be executed by the MMC-Cmd FACTORY_RESET. ☞ Chapter 5.18 ‘MMC-Cmd - Auto commands’ on page 60

1. Switch the CPU to STOP.
2. Push the operating mode switch down to position MRES for 30s. Here the STOP-LED flashes. After a few seconds the stop LED changes to static light. Now the STOP LED changes between static light and flashing. Starting here count the static light states.
3. After the 6. static light release the operating mode switch and tip it downwards to MRES. Now the RUN LED lights up once. This means that the RAM was deleted completely.
4. For the confirmation of the resetting procedure the LEDs PW, ST, SF, FC and MC get ON. If not, the factory reset has failed and only an overall reset was executed. In this case you can repeat the procedure. A factory reset can only be executed if the stop LED has static light for exactly 6 times.
5. The end of factory reset is shown by static light of the LEDs PW, ST, SF, FC and MC. Switch the power supply off and on.

The proceeding is shown in the following Illustration:

The firmware update you always should execute a Reset to factory setting.

---

5.15 Slot for storage media

**Overview**

At the front of the CPU there is a slot for storage media. As external storage medium for applications and firmware you may use a multi-media card (MMC). You can cause the CPU to load a project automatically respectively to execute a command file by means of pre-defined file names.
To the following times an access takes place on a storage medium:

- **After overall reset**
  - The CPU checks if there is a project S7PROG.WLD. If exists the project is automatically loaded.
  - The CPU checks if there is a project PROTECT.WLD with protected blocks. If exists the project is automatically loaded. These blocks are stored in the CPU until the CPU is reset to factory setting or an empty PROTECT.WLD is loaded.
  - The CPU checks if a MCC memory extension card is put. If exists the memory extension is enabled, otherwise a memory expansion, which was activated before, is de-activated.

- **After PowerON**
  - The CPU checks if there is a project AUTOLOAD.WLD. If exists an overall reset is established and the project is automatically loaded.
  - The CPU checks if there is a command file with VIPA_CMD.MMC. If exists the command file is loaded and the containing instructions are executed.
  - After PowerON and CPU STOP the CPU checks if there is a *.pkg file (firmware file). If exists this is indicated by blinking of the LEDs and the firmware may be installed by an update request.

- **Once in STOP**
  - If a storage medium is put, which contains a command file VIPA_CMD.MMC, the command file is loaded and the containing instructions are executed.

### 5.16 Memory extension with MCC

#### Overview

There is the possibility to extend the work memory of the CPU. For this, a MCC memory extension card is available from VIPA. The MCC is a specially prepared MMC (Multimedia Card). By plugging the MCC into the MCC slot and then an overall reset the according memory expansion is released. There may only one memory expansion be activated at one time. On the MCC there is the file memory.key. This file may not be altered or deleted. You may use the MCC also as "normal" MMC for storing your project.

#### Proceeding

To extend the memory, plug the MCC into the card slot at the CPU labelled with "MCC" and execute an overall reset.
If the memory expansion on the MCC exceeds the maximum extendible memory range of the CPU, the maximum possible memory of the CPU is automatically used. You may determine the recent memory extension via the integrated web page or with the Siemens SIMATIC Manager at Module Information - "Memory".

CAUTION!
Please regard that the MCC must remain plugged when you've executed the memory expansion at the CPU. Otherwise the CPU switches to STOP after 72 hours. The MCC cannot be exchanged with a MCC of the same memory configuration.

Behavior
When the MCC memory configuration has been taken over you may find the diagnostic entry 0xE400 in the diagnostic buffer of the CPU.

After pulling the MCC the entry 0xE401 appears in the diagnostic buffer, the SF LED is on and after 72 hours the CPU switches to STOP. A reboot is only possible after plugging-in the MCC again or after an overall reset.

The remaining time after pulling the MCC is always been shown with the parameter MCC-Trial-Time on the web page.

After re-plugging the MCC, the SF LED extinguishes and 0xE400 is entered into the diagnostic buffer. You may reset the memory configuration of your CPU to the initial status at any time by executing an overall reset without MCC.

5.17 Extended know-how protection
Overview
Besides the "standard" Know-how protection the SPEED7-CPU's from VIPA provide an "extended" know-how protection that serves a secure block protection for accesses of 3. persons.

Standard protection
The standard protection from Siemens transfers also protected blocks to the PG but their content is not displayed. But with according manipulation the Know-how protection is not guaranteed.

Extended protection
The "extended" know-how protection developed by VIPA offers the opportunity to store blocks permanently in the CPU. At the "extended" protection you transfer the protected blocks into a WLD-file named protect.wld. By plugging the MMC and following overall reset, the blocks in the protect.wld are permanently stored in the CPU. You may protect OBs, FBs and FCs. When back-reading the protected blocks into the PG, exclusively the block header are loaded. The block code that is to be protected remains in the CPU and cannot be read.
Create a new wld-file in your project engineering tool with ‘File ➔ Memory Card file ➔ New’ and rename it to “protect.wld”. Transfer the according blocks into the file by dragging them with the mouse from the project to the file window of protect.wld.

Transfer the file protect.wld to a MMC storage module, plug the MMC into the CPU and execute an overall reset with the following approach:

The overall reset stores the blocks in protect.wld permanently in the CPU protected from accesses of 3. persons.

Protected blocks are overwritten by a new protect.wld. Using a PG 3. persons may access protected blocks but only the block header is transferred to the PG. The block code that is to be protected remains in the CPU and cannot be read.

Protected blocks in the RAM of the CPU may be substituted at any time by blocks with the same name. This change remains up to next overall reset. Protected blocks may permanently be overwritten only if these are deleted at the protect.wld before. By transferring an empty protect.wld from the MMC you may delete all protected blocks in the CPU.
Due to the fact that reading of a "protected" block from the CPU monitors no symbol labels it is convenient to provide the "block covers" for the end user. For this, create a project out of all protected blocks. Delete all networks in the blocks so that these only contain the variable definitions in the according symbolism.

5.18 MMC-Cmd - Auto commands

Overview

A command file at a MMC is automatically executed under the following conditions:

- CPU is in STOP and MMC is stuck
- After each PowerON

Command file

The command file is a text file, which consists of a command sequence to be stored as vipa_cmd.mmc in the root directory of the MMC. The file has to be started by CMD_START as 1. command, followed by the desired commands (no other text) and must be finished by CMD_END as last command.

Text after the last command CMD_END e.g. comments is permissible, because this is ignored. As soon as the command file is recognized and executed each action is stored at the MMC in the log file logfile.txt. In addition for each executed command a diagnostics entry may be found in the diagnostics buffer.

Commands

Please regard the command sequence is to be started with CMD_START and ended with CMD_END.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Diagnostics entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMD_START</td>
<td>In the first line CMD_START is to be located.</td>
<td>0xE801</td>
</tr>
<tr>
<td></td>
<td>There is a diagnostic entry if CMD_START is missing</td>
<td>0xE8FE</td>
</tr>
<tr>
<td>WAIT1SECOND</td>
<td>Waits about 1 second.</td>
<td>0xE803</td>
</tr>
<tr>
<td>WEBPAGE</td>
<td>The current web page of the CPU is stored at the MMC as &quot;webpage.htm&quot;.</td>
<td>0xE804</td>
</tr>
<tr>
<td>LOAD_PROJECT</td>
<td>The function &quot;Overall reset and reload from MMC&quot; is executed. The wld file located after the command is loaded else &quot;s7prog.wld&quot; is loaded.</td>
<td>0xE805</td>
</tr>
<tr>
<td>SAVE_PROJECT</td>
<td>The recent project (blocks and hardware configuration) is stored as &quot;s7prog.wld&quot; at the MMC. If the file just exists it is renamed to &quot;s7prog.old&quot;. If your CPU is password protected so you have to add this as parameter. Otherwise there is no project written. Example: SAVE_PROJECT password</td>
<td>0xE806</td>
</tr>
<tr>
<td>FACTORY_RESET</td>
<td>Executes &quot;factory reset&quot;.</td>
<td>0xE807</td>
</tr>
<tr>
<td>DIAGBUF</td>
<td>The current diagnostics buffer of the CPU is stored as &quot;diagbuff.txt&quot; at the MMC.</td>
<td>0xE80B</td>
</tr>
</tbody>
</table>
Command | Description | Diagnostics entry
--- | --- | ---
SET_NETWORK | IP parameters for Ethernet PG/OP channel may be set by means of this command. The IP parameters are to be given in the order IP address, subnet mask and gateway in the format x.x.x.x each separated by a comma. Enter the IP address if there is no gateway used. | 0xE80E
CMD_END | In the last line CMD_END is to be located. | 0xE802

**Examples**

The structure of a command file is shown in the following. The corresponding diagnostics entry is put in parentheses.

**Example 1**

CMD_START
LOAD_PROJECT proj.wld
WAIT1SECOND
WEBPAGE
DIAGBUF
CMD_END
... arbitrary text ...

Marks the start of the command sequence (0xE801)
Execute an overall reset and load "proj.wld" (0xE805)
Wait ca. 1s (0xE803)
Store web page as "webpage.htm" (0xE804)
Store diagnostics buffer of the CPU as "diagbuff.txt" (0xE80B)
Marks the end of the command sequence (0xE802)
Text after the command CMD_END is not evaluated.

**Example 2**

CMD_START
LOAD_PROJECT proj2.wld
WAIT1SECOND
WAIT1SECOND
SET_NETWORK
172.16.129.210,255.255.224.0
,172.16.129.210
WAIT1SECOND
WAIT1SECOND
WEBPAGE
DIAGBUF
CMD_END
... arbitrary text ...

Marks the start of the command sequence (0xE801)
Execute an overall reset and load "proj2.wld" (0xE805)
Wait ca. 1s (0xE803)
Wait ca. 1s (0xE803)
IP parameter (0xE80E)
Wait ca. 1s (0xE803)
Wait ca. 1s (0xE803)
Store web page as "webpage.htm" (0xE804)
Store diagnostics buffer of the CPU as "diagbuff.txt" (0xE80B)
Marks the end of the command sequence (0xE802)
Text after the command CMD_END is not evaluated.

The parameters IP address, subnet mask and gateway may be received from the system administrator.
Enter the IP address if there is no gateway used.
5.19 VIPA specific diagnostic entries

Entries in the diagnostic buffer

You may read the diagnostic buffer of the CPU via the Siemens SIMATIC Manager. Besides of the standard entries in the diagnostic buffer, the VIPA CPUs support some additional specific entries in form of event-IDs.

The current content of the diagnostics buffer is stored at the memory card by means of the CMD DIAGBUF.

Every register of the module information is supported by the VIPA CPUs. More information may be found at the online help of the Siemens SIMATIC Manager.

Monitoring the diagnostic entries

To monitor the diagnostic entries you choose the option 'PLC Module Information' in the Siemens SIMATIC Manager. Via the register "Diagnostic Buffer" you reach the diagnostic window:

The diagnosis is independent from the operating mode of the CPU. You may store a max. of 100 diagnostic entries in the CPU. The following page shows an overview of the VIPA specific Event-IDs.

Overview of the Event-IDs

<table>
<thead>
<tr>
<th>Event-ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x115C</td>
<td>Vendor-specific interrupt (OB 57) at EtherCAT</td>
</tr>
<tr>
<td></td>
<td>OB: OB number (57)</td>
</tr>
<tr>
<td></td>
<td>ZInfo1: Logical address of the slave, which has released the interrupt</td>
</tr>
<tr>
<td></td>
<td>ZInfo2: Interrupt type</td>
</tr>
<tr>
<td></td>
<td>ZInfo3: Reserved</td>
</tr>
<tr>
<td>0xE003</td>
<td>Error on accessing the periphery</td>
</tr>
<tr>
<td></td>
<td>ZInfo1: Periphery address</td>
</tr>
<tr>
<td></td>
<td>ZInfo2: Slot</td>
</tr>
<tr>
<td>Event-ID</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>--------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>0xE004</td>
<td>Multiple parametrization of a periphery address</td>
</tr>
<tr>
<td></td>
<td>ZInfo1: Periphery address</td>
</tr>
<tr>
<td></td>
<td>ZInfo2: Slot</td>
</tr>
<tr>
<td>0xE005</td>
<td>Internal error - Please contact the VIPA Hotline!</td>
</tr>
<tr>
<td>0xE006</td>
<td>Internal error - Please contact the VIPA Hotline!</td>
</tr>
<tr>
<td>0xE007</td>
<td>Configured in-/output bytes do not fit into periphery area</td>
</tr>
<tr>
<td>0xE008</td>
<td>Internal error - Please contact the VIPA Hotline!</td>
</tr>
<tr>
<td>0xE009</td>
<td>Error on accessing the standard backplane bus</td>
</tr>
<tr>
<td>0xE010</td>
<td>There is a undefined module at the backplane bus</td>
</tr>
<tr>
<td></td>
<td>ZInfo2: Slot</td>
</tr>
<tr>
<td></td>
<td>ZInfo3: Type ID</td>
</tr>
<tr>
<td>0xE011</td>
<td>Master project engineering at slave CPU not possible or wrong slave configuration</td>
</tr>
<tr>
<td>0xE012</td>
<td>Error at parametrization</td>
</tr>
<tr>
<td>0xE013</td>
<td>Error at shift register access to standard bus digital modules</td>
</tr>
<tr>
<td>0xE014</td>
<td>Error at Check_Sys</td>
</tr>
<tr>
<td>0xE015</td>
<td>Error at access to the master</td>
</tr>
<tr>
<td></td>
<td>ZInfo2: Slot of the master (32=page frame master)</td>
</tr>
<tr>
<td>0xE016</td>
<td>Maximum block size at master transfer exceeded</td>
</tr>
<tr>
<td></td>
<td>ZInfo1: Periphery address</td>
</tr>
<tr>
<td></td>
<td>ZInfo2: Slot</td>
</tr>
<tr>
<td>0xE017</td>
<td>Error at access to integrated slave</td>
</tr>
<tr>
<td>0xE018</td>
<td>Error at mapping of the master periphery</td>
</tr>
<tr>
<td>0xE019</td>
<td>Error at standard back plane bus system recognition</td>
</tr>
<tr>
<td>0xE01A</td>
<td>Error at recognition of the operating mode (8 / 9 bit)</td>
</tr>
<tr>
<td>0xE01B</td>
<td>Error - Maximum number of plug-in modules exceeded</td>
</tr>
<tr>
<td>0xE020</td>
<td>Error - Interrupt information is not defined</td>
</tr>
<tr>
<td>0xE030</td>
<td>Error of the standard bus</td>
</tr>
<tr>
<td>0xE033</td>
<td>Internal error - Please contact the VIPA Hotline!</td>
</tr>
<tr>
<td>0xE0B0</td>
<td>SPEED7 is not stoppable</td>
</tr>
<tr>
<td></td>
<td>(Probably undefined BCD value at timer)</td>
</tr>
<tr>
<td>0xE0C0</td>
<td>Not enough space in work memory for storing code block (block size exceeded)</td>
</tr>
<tr>
<td>0xE0CB</td>
<td>Error at SSL access</td>
</tr>
<tr>
<td></td>
<td>ZInfo1: 4=SSL wrong, 5=SubSSL wrong, 6=Index wrong</td>
</tr>
<tr>
<td></td>
<td>ZInfo2: SSL-ID</td>
</tr>
<tr>
<td></td>
<td>ZInfo3: Index</td>
</tr>
<tr>
<td>Event-ID</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>0xE0CC</td>
<td>Communication error MPI / Serial</td>
</tr>
<tr>
<td></td>
<td>ZInfo1: Code</td>
</tr>
<tr>
<td></td>
<td>1: Wrong priority</td>
</tr>
<tr>
<td></td>
<td>2: Buffer overflow</td>
</tr>
<tr>
<td></td>
<td>3: Frame format error</td>
</tr>
<tr>
<td></td>
<td>4: Wrong SSL request (SSL-ID not valid)</td>
</tr>
<tr>
<td></td>
<td>5: Wrong SSL request (SSL-SubID not valid)</td>
</tr>
<tr>
<td></td>
<td>6: Wrong SSL request (SSL-Index not valid)</td>
</tr>
<tr>
<td></td>
<td>7: Wrong value</td>
</tr>
<tr>
<td></td>
<td>8: Wrong RetVal</td>
</tr>
<tr>
<td></td>
<td>9: Wrong SAP</td>
</tr>
<tr>
<td></td>
<td>10: Wrong connection type</td>
</tr>
<tr>
<td></td>
<td>11: Wrong sequence number</td>
</tr>
<tr>
<td></td>
<td>12: Faulty block number in the telegram</td>
</tr>
<tr>
<td></td>
<td>13: Faulty block type in the telegram</td>
</tr>
<tr>
<td></td>
<td>14: Inactive function</td>
</tr>
<tr>
<td></td>
<td>15: Wrong size in the telegram</td>
</tr>
<tr>
<td></td>
<td>20: Error writing to memory card</td>
</tr>
<tr>
<td></td>
<td>90: Faulty buffer size</td>
</tr>
<tr>
<td></td>
<td>98: Unknown error</td>
</tr>
<tr>
<td></td>
<td>99: Internal error</td>
</tr>
<tr>
<td>0xE0CD</td>
<td>Error at DP-V1 job management</td>
</tr>
<tr>
<td>0xE0CE</td>
<td>Error: Timeout at sending of the i-slave diagnostics</td>
</tr>
<tr>
<td>0xE0CF</td>
<td>Timeout at loading of a new HW configuration (timeout: 39 seconds)</td>
</tr>
<tr>
<td>0xE100</td>
<td>Memory card access error</td>
</tr>
<tr>
<td>0xE101</td>
<td>Memory card error file system</td>
</tr>
<tr>
<td>0xE102</td>
<td>Memory card error FAT</td>
</tr>
<tr>
<td>0xE104</td>
<td>Memory card error at saving</td>
</tr>
<tr>
<td>0xE200</td>
<td>Memory card writing finished (Copy Ram2Rom)</td>
</tr>
<tr>
<td>0xE210</td>
<td>Memory card reading finished (reload after overall reset)</td>
</tr>
<tr>
<td>0xE21E</td>
<td>Memory card reading: Error at reload (after overall reset), file &quot;Protect.wld&quot; too big</td>
</tr>
<tr>
<td>0xE21F</td>
<td>Memory card reading: Error at reload (after overall reset), file read error, out of memory</td>
</tr>
<tr>
<td>0xE300</td>
<td>Internal flash writing finished (Copy Ram2Rom)</td>
</tr>
<tr>
<td>0xE310</td>
<td>Internal flash writing finished (reload after battery failure)</td>
</tr>
<tr>
<td>0xE311</td>
<td>Internal flash fx0000yy.wld file too big, load failure</td>
</tr>
<tr>
<td>Event-ID</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>0xE400</td>
<td>Memory card with the option memory expansion was plugged</td>
</tr>
<tr>
<td>0xE401</td>
<td>Memory card with the option memory expansion was removed</td>
</tr>
<tr>
<td>0xE402</td>
<td>The PROFIBUS DP master functionality is disabled. The interface acts further as MPI interface</td>
</tr>
<tr>
<td>0xE403</td>
<td>The PROFIBUS DP slave functionality is disabled. The interface acts further as MPI interface</td>
</tr>
</tbody>
</table>
| 0xE500   | Memory management: Deleted block without corresponding entry in Block List  
ZInfo2: BlockType  
ZInfo3: BlockNo |
| 0xE604   | Multiple parametrization of a periphery address for Ethernet PG/OP channel  
ZInfo1: Periphery address  
ZInfo3:  
0: Periphery address is input, 1: Periphery address is output |
<p>| 0xE701   | Internal error - Please contact the VIPA Hotline! |
| 0xE703   | Internal error - Please contact the VIPA Hotline! |
| 0xE720   | Internal error - Please contact the VIPA Hotline! |
| 0xE721   | Internal error - Please contact the VIPA Hotline! |
| 0xE801   | CMD - Auto command: CMD_START recognized and successfully executed |
| 0xE802   | CMD - Auto command: CMD_End recognized and successfully executed |
| 0xE803   | CMD - Auto command: WAIT1SECOND recognized and successfully executed |
| 0xE804   | CMD - Auto command: WEBPAGE recognized and successfully executed |
| 0xE805   | CMD - Auto command: LOAD_PROJECT recognized and successfully executed |
| 0xE806   | CMD - Auto command: SAVE_PROJECT recognized and successfully executed |
| 0xE807   | CMD - Auto command: FACTORY_RESET recognized and successfully executed |
| 0xE80B   | CMD - Auto command: DIAGBUF recognized and successfully executed |
| 0xE80E   | CMD - Auto command: SET_NETWORK recognized and successfully executed |
| 0xE8FB   | CMD - Auto command: Error: Initialization of the Ethernet PG/OP channel by means of SET_NETWORK is faulty |
| 0xE8FC   | CMD - Auto command: Error: Some IP parameters missing in SET_NETWORK |
| 0xE8FE   | CMD - Auto command: Error: CMD_START missing |</p>
<table>
<thead>
<tr>
<th>Event-ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0xE8FF</td>
<td>CMD - Auto command: Error: Error while reading CMD file (memory card error)</td>
</tr>
<tr>
<td>0xE901</td>
<td>Check sum error</td>
</tr>
<tr>
<td>0xEA00</td>
<td>Internal error - Please contact the VIPA Hotline!</td>
</tr>
<tr>
<td>0xEA01</td>
<td>Internal error - Please contact the VIPA Hotline!</td>
</tr>
<tr>
<td>0xEA02</td>
<td>SBUS: Internal error (internal plugged sub module not recognized) &lt;br&gt;ZInfo1: Internal slot</td>
</tr>
<tr>
<td>0xEA03</td>
<td>SBUS: Communication error CPU - PROFINET I/O controller: &lt;br&gt;ZInfo1: Slot &lt;br&gt;ZInfo2: Status &lt;br&gt;(0: OK, 1: ERROR, 2: BUSSY, 3: TIMEOUT, 4: LOCKED, 5: UNKNOWN)</td>
</tr>
<tr>
<td>0xEA04</td>
<td>SBUS: Multiple parametrization of a periphery address &lt;br&gt;zInfo1: Periphery address &lt;br&gt;zInfo2: Slot &lt;br&gt;zInfo3: Data width</td>
</tr>
<tr>
<td>0xEA05</td>
<td>Internal error - Please contact the VIPA Hotline!</td>
</tr>
<tr>
<td>0xEA07</td>
<td>Internal error - Please contact the VIPA Hotline!</td>
</tr>
<tr>
<td>0xEA08</td>
<td>SBUS: Parametrized input data width unequal to plugged input data width &lt;br&gt;zInfo1: Parametrized input data width &lt;br&gt;zInfo2: Slot &lt;br&gt;zInfo3: Input data width of the plugged module</td>
</tr>
<tr>
<td>0xEA09</td>
<td>SBUS: Parametrized output data width unequal to plugged output data width &lt;br&gt;zInfo1: Parametrized output data width &lt;br&gt;zInfo2: Slot &lt;br&gt;zInfo3: Output data width of the plugged module</td>
</tr>
<tr>
<td>0xEA10</td>
<td>SBUS: Input periphery address outside the periphery area &lt;br&gt;zInfo1: Periphery address &lt;br&gt;zInfo2: Slot &lt;br&gt;zInfo3: Data width</td>
</tr>
<tr>
<td>0xEA11</td>
<td>SBUS: Output periphery address outside the periphery area &lt;br&gt;zInfo1: Periphery address &lt;br&gt;zInfo2: Slot &lt;br&gt;zInfo3: Data width</td>
</tr>
<tr>
<td>Event-ID</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| 0xEA12   | SBUS: Error at writing record set  
ZInfo1: Slot  
ZInfo2: Record set number  
ZInfo3: Record set length |
| 0xEA14   | SBUS: Multiple parametrization of a periphery address (diagnostics address)  
ZInfo1: Periphery address  
ZInfo2: Slot  
ZInfo3: Data width |
| 0xEA15   | Internal error - Please contact the VIPA Hotline! |
| 0xEA18   | SBUS: Error at mapping of the master periphery  
ZInfo2: Slot of the master |
| 0xEA19   | Internal error - Please contact the VIPA Hotline! |
| 0xEA20   | Error - RS485 interface is not pre-set to PROFIBUS DP master bus a PROFIBUS DP master is configured. |
| 0xEA21   | Error - Configuration RS485 interface X2/X3: PROFIBUS DP master is configured but missing  
ZInfo2: Interface x |
| 0xEA22   | Error - RS485 interface X2 - Value exceeds the limits  
ZInfo: Configured value of X2 |
| 0xEA23   | Error - RS485 interface X3 - Value exceeds the limits  
ZInfo: Configured value of X3 |
| 0xEA24   | Error - Configuration RS485 interface X2/X3: Interface/protocol missing, default settings are used  
ZInfo2: Configured value for X2  
ZInfo3: Configured value for X3 |
| 0xEA30   | Internal error - Please contact the VIPA Hotline! |
| 0xEA40   | Internal error - Please contact the VIPA Hotline! |
| 0xEA41   | Internal error - Please contact the VIPA Hotline! |
| 0xEA50   | Error - PROFINET configuration  
ZInfo1: User slot of the PROFINET I/O controller  
ZInfo2: IO-Device-No.  
ZInfo3: IO-Device slot |
| 0xEA51   | Error - There is no PROFINET IO controller at the configured slot  
ZInfo1: User slot of the PROFINET I/O controller  
ZInfo2: Recognized ID at the configured slot |
<table>
<thead>
<tr>
<th>Event-ID</th>
<th>Description</th>
</tr>
</thead>
</table>
| 0xEA53   | Error - PROFINET configuration - There are too many PROFINET IO devices configured  
ZInfo1: Number of configured devices  
ZInfo2: Slot  
ZInfo3: Maximum possible number of devices |
| 0xEA54   | Error - PROFINET IO controller reports multiple parametrization of a periphery address  
ZInfo1: Periphery address  
ZInfo2: User slot of the PROFINET I/O controller  
ZInfo3: Data width |
| 0xEA61 ... 0xEA63 | Internal error - Please contact the VIPA Hotline! |
| 0xEA64   | PROFINET/EtherCAT CP  
Configuration error: Zinfo1:  
Bit 0: Too many devices  
Bit 1: Too many devices per ms  
Bit 2: Too many input bytes per ms  
Bit 3: Too many output bytes per ms  
Bit 4: Too many input bytes per device  
Bit 5: Too many output bytes per device  
Bit 6: Too many productive connections  
Bit 7: Too many input bytes in the process image  
Bit 8: Too many output bytes in the process image  
Bit 9: Configuration not available  
Bit 10: Configuration not valid  
Bit 11: Cycle time too small  
Bit 12: Cycle time too big  
Bit 13: Not valid device number  
Bit 14: CPU is configured as I device  
Bit 15: Obtain an IP address in a different way is not supported for the IP address of the controller |
| 0xEA65   | Internal error - Please contact the VIPA Hotline! |
| 0xEA66   | PROFINET IO controller  
Error in communication stack  
PK: Rackslot  
OBNr: StackError.Service  
DatId: StackError.DeviceRef  
ZInfo1: StackError.Error.Code  
ZInfo2: StackError.Error.Detail  
ZInfo3: StackError.Error.AdditionalDetail  
<< 8 + StackError.Error.AreaCode |
<table>
<thead>
<tr>
<th>Event-ID</th>
<th>Description</th>
</tr>
</thead>
</table>
| 0xEA67   | Error - PROFINET IO controller - reading record set  
PK: Error type  
0: DATA_RECORD_ERROR_LOCAL  
1: DATA_RECORD_ERROR_STACK  
2: DATA_RECORD_ERROR_REMOTE  
OBNo: PROFINET IO controller slot  
DatId: Device-No.  
ZInfo1: Record set number  
ZInfo2: Record set handle  
ZInfo3: Internal error code for service purposes |
| 0xEA68   | Error - PROFINET IO controller - writing record set  
PK: Error type  
0: DATA_RECORD_ERROR_LOCAL  
1: DATA_RECORD_ERROR_STACK  
2: DATA_RECORD_ERROR_REMOTE  
OBNo: PROFINET IO controller slot  
DatId: Device-No.  
ZInfo1: Record set number  
ZInfo2: Record set handle  
ZInfo3: Internal error code for service purposes |
| 0xEA69   | Internal error - Please contact the VIPA Hotline! |
| 0xEA6A   | PROFINET IO controller  
Service error in communication stack  
PK: Rackslot  
OBNo: ServiceIdentifier  
DatId: 0  
ZInfo1: ServiceError.Code  
ZInfo2: ServiceError.Detail  
ZInfo3: StackError.Error.AdditionalDetail |
| 0xEA6B   | PROFINET IO controller  
Vendor ID mismatch  
PK: Rackslot  
OBNo: PLC Mode  
DatId: 0  
ZInfo1: Device ID  
ZInfo2: -  
ZInfo3: - |
<table>
<thead>
<tr>
<th>Event-ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0xEA6C</td>
<td>PROFINET IO controller</td>
</tr>
<tr>
<td></td>
<td>Device ID mismatch</td>
</tr>
<tr>
<td></td>
<td>PK: Rackslot</td>
</tr>
<tr>
<td></td>
<td>OBNo: PLC Mode</td>
</tr>
<tr>
<td></td>
<td>DatId: 0</td>
</tr>
<tr>
<td></td>
<td>ZInfo1: Device ID</td>
</tr>
<tr>
<td></td>
<td>ZInfo2: -</td>
</tr>
<tr>
<td></td>
<td>ZInfo3: -</td>
</tr>
<tr>
<td>0xEA6D</td>
<td>PROFINET IO controller</td>
</tr>
<tr>
<td></td>
<td>No empty name</td>
</tr>
<tr>
<td></td>
<td>PK: Rackslot</td>
</tr>
<tr>
<td></td>
<td>OBNo: PLC Mode</td>
</tr>
<tr>
<td></td>
<td>DatId: 0</td>
</tr>
<tr>
<td></td>
<td>ZInfo1: Device ID</td>
</tr>
<tr>
<td></td>
<td>ZInfo2: -</td>
</tr>
<tr>
<td></td>
<td>ZInfo3: -</td>
</tr>
<tr>
<td>0xEA6E</td>
<td>PROFINET IO controller</td>
</tr>
<tr>
<td></td>
<td>RPC response missing</td>
</tr>
<tr>
<td></td>
<td>PK: Rackslot</td>
</tr>
<tr>
<td></td>
<td>OBNo: PLC Mode</td>
</tr>
<tr>
<td></td>
<td>DatId: 0</td>
</tr>
<tr>
<td></td>
<td>ZInfo1: Device ID</td>
</tr>
<tr>
<td></td>
<td>ZInfo2: -</td>
</tr>
<tr>
<td></td>
<td>ZInfo3: -</td>
</tr>
<tr>
<td>0xEA6F</td>
<td>PROFINET IO controller</td>
</tr>
<tr>
<td></td>
<td>PN module mismatch</td>
</tr>
<tr>
<td></td>
<td>PK: Rackslot</td>
</tr>
<tr>
<td></td>
<td>OBNo: PLC-Mode</td>
</tr>
<tr>
<td></td>
<td>DatId: 0</td>
</tr>
<tr>
<td></td>
<td>ZInfo1: Device ID</td>
</tr>
<tr>
<td></td>
<td>ZInfo2: -</td>
</tr>
<tr>
<td></td>
<td>ZInfo3: -</td>
</tr>
<tr>
<td>0xEA7</td>
<td>Storage error SBUS service channel</td>
</tr>
<tr>
<td></td>
<td>ZInfo3 = Slot</td>
</tr>
<tr>
<td>0xEA98</td>
<td>Timeout at waiting for reboot of a SBUS module (server)</td>
</tr>
<tr>
<td>0xEA99</td>
<td>Error at file reading via SBUS</td>
</tr>
<tr>
<td>Event-ID</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| 0xEAA0   | Emac Error occurred  
|          | OBNo: Current PLC mode  
|          | ZInfo1: Diagnostics address of the master / controller  
|          | ZInfo2:  
|          | 0: None Rx queue is full  
|          | 1: No send buffer available  
|          | 2: Send stream was cut off; sending failed  
|          | 3: Exhausted retries  
|          | 4: No receive buffer available in Emac DMA  
|          | 5: Emac DMA transfer aborted  
|          | 6: Queue overflow  
|          | 7: Unexpected frame received  
|          | ZInfo3: Number of errors, which occurred |
| 0xEAB0   | Link mode not valid  
|          | OBNo: Current PLC mode  
|          | ZInfo1: Diagnostics address master / controller  
|          | Zinfo2: Current LinkMode  
|          | 0x01: 10Mbit full-duplex  
|          | 0x02: 100Mbit half-duplex  
|          | 0x03: 100Mbit full-duplex  
|          | 0x05: 10Mbit half-duplex  
|          | 0xFF: Link mode not defined  |
| 0xEB03   | SLIO error on IO mapping  |
| 0xEB10   | SLIO error: Bus error  
|          | ZInfo1: Type of error  
<p>|          | 0x82: ErrorAlarm  |
| 0xEB20   | SLIO error: Interrupt information undefined  |
| 0xEB21   | SLIO error on accessing the configuration data  |</p>
<table>
<thead>
<tr>
<th>Event-ID</th>
<th>Description</th>
</tr>
</thead>
</table>
| 0xEC03   | EtherCAT: Configuration error  
ZInfo1: Errorcode  
1: NUMBER_OF_SLAVES_NOT_SUPPORTED  
2: SYSTEM_IO_NR_INVALID  
3: INDEX_FROM_SLOT_ERROR  
4: MASTER_CONFIG_INVALID  
5: MASTER_TYPE_ERROR  
6: SLAVE_DIAG_ADDR_INVALID  
7: SLAVE_ADDR_INVALID  
8: SLAVE_MODULE_IO_CONFIG_INVALID  
9: LOG_ADDR_ALREADY_IN_USE  
10: NULL_PTR_CHECK_ERROR  
11: IO_MAPPING_ERROR  
12: ERROR |
| 0xEC04   | EtherCAT: Multiple configuration of a periphery address  
ZInfo1: Periphery address  
ZInfo2: Slot |
| 0xEC10   | EtherCAT: Restoration bus with its slaves  
OB start Info (Local data) StartEvent and Eventclass: 0xEC10  
DatID:  
0xXXYY:  
XX=0x54 with input address in ZInfo1,  
XX=0x55 with output address.  
YY=0x00 Station not available,  
YY=0x01 Station available (process data)  
ZInfo1: 0xXXYY (XX=OldState, YY=NewState)  
ZInfo2: Diagnostics address of the master  
ZInfo3: Number of stations, which are not in the same state as the master (> 0) |
<table>
<thead>
<tr>
<th>Event-ID</th>
<th>Description</th>
</tr>
</thead>
</table>
| 0xEC11   | EtherCAT: Restoration bus with missing slaves  
OB start Info (Local data) StartEvent and Eventclass: 0xEC11  
DatID:  
0xXXYY:  
XX=0x54 with input address in ZInfo1,  
XX=0x55 with output address.  
YY=0x00 Station not available,  
YY=0x01 Station available (process data)  
ZInfo1: 0xXXYY (XX=OldState, YY=NewState)  
ZInfo2: Diagnostics address of the master  
ZInfo3: Number of stations, which are not in the same state as the master (> 0) |
| 0xEC12   | EtherCAT: restoration slave  
OB start Info (Local data) StartEvent and Eventclass: 0xEC12  
DatID:  
0xXXYY:  
XX=0x54 with input address in ZInfo1,  
XX=0x55 with output address.  
YY=0x00 Station not available,  
YY=0x01 Station available (process data)  
ZInfo1: 0xXXYY (XX=OldState, YY=NewState)  
ZInfo2: Diagnostics of the Station  
ZInfo3: AlStatusCode |
| 0xEC30   | EtherCAT: Topology OK  
OB start Info (Local data) StartEvent and Eventclass: 0xEC30  
ZInfo2: Diagnostics address of the master |
| 0xEC50   | EtherCAT: DC not in Sync  
ZInfo1: Diagnostics address of the master |
| 0xED10   | EtherCAT: Bus failure  
OB start Info (Local data) StartEvent and Eventclass: 0xED10  
DatID:  
0xXXYY:  
XX=0x54 with input address in ZInfo1,  
XX=0x55 with output address.  
YY=0x00 Station not available,  
YY=0x01 Station available (process data)  
ZInfo1: 0xXXYY (XX=OldState, YY=NewState)  
ZInfo2: Diagnostics address of the master  
ZInfo3: Number of stations, which are not in the same state as the master |
<table>
<thead>
<tr>
<th>Event-ID</th>
<th>Description</th>
</tr>
</thead>
</table>
| 0xED12   | EtherCAT: Failure slave  
OB start Info (Local data) StartEvent and Eventclass: 0xED12  
DatID:  
0xXXYY:  
XX=0x54 with input address in ZInfo1,  
XX=0x55 with output address.  
YY=0x00 Station not available,  
YY=0x01 Station available (process data)  
ZInfo1: 0xXXYY (XX=OldState, YY=NewState)  
ZInfo2: Diagnostics of the Station  
ZInfo3: AIStatusCode |
| 0xED20   | EtherCAT: Bus state change without calling OB86  
OB start Info (Local data) StartEvent and Eventclass: 0xED20  
DatID:  
0xXXYY:  
XX=0x54 with input address in ZInfo1,  
XX=0x55 with output address.  
YY=0x00 Station not available,  
YY=0x01 Station available (process data)  
ZInfo1: 0xXXYY (XX=OldState, YY=NewState)  
ZInfo2: Diagnostics address of the master  
ZInfo3: Number of stations, which are not in the same state as the master |
| 0xED21   | EtherCAT: error in bus state change  
OB: 0x00  
PK: 0x00  
DatID:  
0xXXYY:  
XX=0x54 with input address in ZInfo1,  
XX=0x55 with output address.  
YY=0x00 Station not available,  
YY=0x01 Station available (process data)  
ZInfo1: 0xXXYY (XX = current state, YY = expected state)  
ZInfo2: Diagnostics address of the master  
ZInfo3: ErrorCode:  
0x0008: Busy  
0x000B: Invalid Parameter  
0x000E: Invalid State  
0x0010: Timeout |
<table>
<thead>
<tr>
<th>Event-ID</th>
<th>Description</th>
</tr>
</thead>
</table>
| 0xED22    | EtherCAT: Bus state change without calling OB86  
OB start Info (Local data) StartEvent and Eventclass: 0xED22  
DatID:  
0xXXYY:  
XX=0x54 with input address in ZInfo1,  
XX=0x55 with output address.  
YY=0x00 Station not available,  
YY=0x01 Station available (process data)  
ZInfo1: 0xXXYY (XX=OldState, YY=NewState)  
ZInfo2: Diagnostics of the Station  
ZInfo3: ALStatusCode |
| 0xED30    | EtherCAT: Topology Mismatch  
OB start Info (Local data) StartEvent and Eventclass: 0xED30  
ZInfo2: Diagnostics address of the master |
| 0xED31    | EtherCAT: Interrupt Queue Overflow  
OB start Info (Local data) StartEvent and Eventclass: 0xED31  
ZInfo2: Diagnostics address of the master |
| 0xED40 ... 0xED4F | Internal error - Please contact the VIPA Hotline! |
| 0xED50    | EtherCAT: DC not in Sync  
ZInfo1: Diagnostics address of the master |
| 0xED60    | EtherCAT: Diagnostics buffer CP:  
Slave state change  
PK: 0  
OB: PLC-Mode  
DatID 1/2: 0  
ZInfo1: 0x00YY:  
YY: New EtherCAT state of the slave  
ZInfo2: EtherCAT station address  
ZInfo3: ALStatusCode (EtherCAT specific error code) |
<table>
<thead>
<tr>
<th>Event-ID</th>
<th>Description</th>
</tr>
</thead>
</table>
| 0xED61   | EtherCAT: Diagnostics buffer CP:  
CoE emergency  
PK: EtherCAT station address (low byte)  
OB: EtherCAT station address (high byte)  
DatID 1/2: Error code  
ZInfo1: 0xYYZZ:  
YY: Error register  
ZZ: MEF byte 1  
ZInfo 2: 0xYYZZ:  
YY: MEF byte 2  
ZZ: MEF byte 3  
ZInfo3: 0xYYZZ:  
YY: MEF byte 4  
ZZ: MEF byte 5 |
| 0xED62   | EtherCAT: Diagnostics buffer CP:  
Error on SDO access during state change  
PK: EtherCAT station address (low byte)  
OB: EtherCAT station address (high byte)  
DatID 1/2: Subindex  
ZInfo1: Index  
ZInfo2: SDO error code (high word)  
ZInfo3: SDO error code (low word) |
| 0xED70   | EtherCAT: Diagnostics buffer CP:  
Twice HotConnect group found  
PK: 0  
OB: PLC-Mode  
DatID 1/2: 0  
ZInfo1: Diagnostics address of the master  
ZInfo2: EtherCAT station address  
ZInfo3: 0 |
<p>| 0xEE00   | Additional information at UNDEF_OPCODE |
| 0xEE01   | Internal error - Please contact the VIPA Hotline! |
| 0xEEEE   | CPU was completely overall reset, since after PowerON the start-up could not be finished. |
| 0xEF11 ... 0xEF13 | Internal error - Please contact the VIPA Hotline! |</p>
<table>
<thead>
<tr>
<th>Event-ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0xFFFFFFFF</td>
<td>Internal error - Please contact the VIPA Hotline!</td>
</tr>
</tbody>
</table>

PK: C-Source module number | DatId: Line number

5.20 Control and monitoring of variables with test functions

Overview

For troubleshooting purposes and to display the status of certain variables you can access certain test functions via the menu item Debug of the Siemens SIMATIC Manager.

The status of the operands and the RLO can be displayed by means of the test function 'Debug ➔ Monitor'.

You can modify and/or display the status of variables by means of the test function ‘PLC ➔ Monitor/Modify Variables’.

‘Debug ➔ Monitor’

This test function displays the current status and the RLO of the different operands while the program is being executed.

It is also possible to enter corrections to the program.

When using the test function “Monitor” the PLC must be in RUN mode!

The processing of the states may be interrupted by means of jump commands or by timer and process-related alarms. At the breakpoint the CPU stops collecting data for the status display and instead of the required data it only provides the PG with data containing the value 0.

For this reason, jumps or time and process alarms can result in the value displayed during program execution remaining at 0 for the items below:

- the result of the logical operation RLO
- Status / AKKU 1
- AKKU 2
- Condition byte
- absolute memory address SAZ. In this case SAZ is followed by a "?".

The interruption of the processing of statuses does not change the execution of the program. It only shows that the data displayed is no longer.

‘PLC ➔ Monitor/Modify Variables’

This test function returns the condition of a selected operand (inputs, outputs, flags, data word, counters or timers) at the end of program-execution.

This information is obtained from the process image of the selected operands. During the "processing check" or in operating mode STOP the periphery is read directly from the inputs. Otherwise only the process image of the selected operands is displayed.

Control of outputs
It is possible to check the wiring and proper operation of output modules.

You can set outputs to any desired status with or without a control program. The process image is not modified but outputs are no longer inhibited.

Control of variables

The following variables may be modified: I, Q, M, T, C and D.

The process image of binary and digital operands is modified independently of the operating mode of the CPU.

When the operating mode is RUN the program is executed with the modified process variable. When the program continues they may, however, be modified again without notification.

Process variables are controlled asynchronously to the execution sequence of the program.
6 Deployment PtP communication

6.1 Fast introduction

**General**

The CPU has a RS485 interface with a fix pinout. Die function of this interface may be set by selecting the corresponding ‘Operating mode’ of the PROFIBUS part of the Siemens CPU (315-2AG10-0AB00 V2.6).

- PROFIBUS DP slave function
  - To activate the PROFIBUS DP slave function to link and switch the PROFIBUS part to slave ‘Operating mode’.

- PtP function
  - Using the PtP (point to point) function the RS485 interface is allowed to connect via serial point-to-point connection to different source or target systems.
  - To activate the PtP function you have to switch the PROFIBUS part to master ‘Operating mode’ without linking.

**Protocols**

The protocols res. procedures ASCII, STX/ETX, 3964R, USS and Modbus are supported.

**Parametrization**

The parametrization of the serial interface happens during runtime using the FC/SFC 216 (SER_CFG). For this you have to store the parameters in a DB for all protocols except ASCII.

**Communication**

The FCs/SFCs are controlling the communication. Send takes place via FC/SFC 217 (SER_SND) and receive via FC/SFC 218 (SER_RCV). The repeated call of the FC/SFC 217 SER_SND delivers a return value for 3964R, USS and Modbus via RetVal that contains, among other things, recent information about the acknowledgment of the partner station. The protocols USS and Modbus allow to evaluate the receipt telegram by calling the FC/SFC 218 SER_RCV after SER_SND. The FCs/SFCs are included in the consignment of the CPU.

**Overview FCs/SFCs for serial communication**

The following FCs/SFCs are used for the serial communication:

<table>
<thead>
<tr>
<th>FC/SFC</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FC/SFC 216</td>
<td>SER_CFG</td>
</tr>
<tr>
<td>FC/SFC 217</td>
<td>SER_SND</td>
</tr>
<tr>
<td>FC/SFC 218</td>
<td>SER_RCV</td>
</tr>
</tbody>
</table>
6.2 Principle of the data transfer

Overview

The data transfer is handled during runtime by using FC/SFCs. The principle of data transfer is the same for all protocols and is shortly illustrated in the following.

- Data, which are written into the according data channel by the CPU, is stored in a FIFO send buffer (first in first out) with a size of 2x1024 byte and then put out via the interface.
- When the interface receives data, this is stored in a FIFO receive buffer with a size of 2x1024 byte and can there be read by the CPU.
- If the data is transferred via a protocol, the embedding of the data to the according protocol happens automatically.
- In opposite to ASCII and STX/ETX, the protocols 3964R, USS and Modbus require the acknowledgement of the partner.
- An additional call of the FC/SFC 217 SER_SND causes a return value in RetVal that includes among others recent information about the acknowledgement of the partner.
- Further on for USS and Modbus after a SER_SND the acknowledgement telegram must be evaluated by a call of the FC/SFC 218 SER_RCV.

RS485 PtP communication

![Diagram of RS485 PtP communication](image)

6.3 Deployment of RS485 interface for PtP

Activating the RS485 for PtP operation

Die function of this interface may be set by selecting the corresponding ‘Operating mode’ of the PROFIBUS part of the Siemens CPU (315-2AG10-0AB00 V2.6) during the hardware configuration. To activate the PtP function you have to switch the PROFIBUS part to master ‘Operating mode’ without linking.

Hardware configuration

1. Start the Siemens hardware configurator.
2. Configure the CPU 315-2AG10 (6ES7 315-2AG10-0AB0/V2.6) from Siemens.
3. To use the interface as PtP interface leave at ‘Properties PROFIBUS’ the ‘Subnet’ set to ‘not networked’.
4. You may also open the Properties dialog of the PROFIBUS part of the inserted CPU by double-clicking to the ‘DP’ submodule, choosing the ‘Operating mode’ DP Master and setting the ‘Subnet’ to "not networked".

Properties RS485
- Logical states represented by voltage differences between the two cores of a twisted pair cable
- Serial bus connection in two-wire technology using half duplex mode
- Data communications up to a max. distance of 500m
- Data communication rate up to 115.2kbaud

RS485
9pin SubD jack

<table>
<thead>
<tr>
<th>Pin</th>
<th>RS485</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>n.c.</td>
</tr>
<tr>
<td>2</td>
<td>M24V</td>
</tr>
<tr>
<td>3</td>
<td>RxD/TxD-P (Line B)</td>
</tr>
<tr>
<td>4</td>
<td>RTS</td>
</tr>
<tr>
<td>5</td>
<td>M5V</td>
</tr>
<tr>
<td>6</td>
<td>P5V</td>
</tr>
<tr>
<td>7</td>
<td>P24V</td>
</tr>
<tr>
<td>8</td>
<td>RxD/TxD-N (Line A)</td>
</tr>
<tr>
<td>9</td>
<td>n.c.</td>
</tr>
</tbody>
</table>

Connection
6.4 Parametrization

6.4.1 FC/SFC 216 - SER_CFG

**Description**
The parametrization happens during runtime deploying the FC/SFC 216 (SER_CFG). You have to store the parameters for STX/ETX, 3964R, USS and Modbus in a DB.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Declaration</th>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PROTOCOL</td>
<td>IN</td>
<td>BYTE</td>
<td>1=ASCII, 2=STX/ETX, 3=3964R</td>
</tr>
<tr>
<td>PARAMETER</td>
<td>IN</td>
<td>ANY</td>
<td>Pointer to protocol-parameters</td>
</tr>
<tr>
<td>BAUDRATE</td>
<td>IN</td>
<td>BYTE</td>
<td>Number of baudrate</td>
</tr>
<tr>
<td>CHARLEN</td>
<td>IN</td>
<td>BYTE</td>
<td>0=5bit, 1=6bit, 2=7bit, 3=8bit</td>
</tr>
<tr>
<td>PARITY</td>
<td>IN</td>
<td>BYTE</td>
<td>0=Non, 1=Odd, 2=Even</td>
</tr>
<tr>
<td>STOPBITS</td>
<td>IN</td>
<td>BYTE</td>
<td>1=1bit, 2=1.5bit, 3=2bit</td>
</tr>
<tr>
<td>FLOWCONTROL</td>
<td>IN</td>
<td>BYTE</td>
<td>1 (fix)</td>
</tr>
<tr>
<td>RETVAL</td>
<td>OUT</td>
<td>WORD</td>
<td>Return value (0 = OK)</td>
</tr>
</tbody>
</table>

All time settings for timeouts must be set as hexadecimal value. Find the Hex value by multiply the wanted time in seconds with the baudrate.

Example:
Wanted time 8ms at a baudrate of 19200baud
Calculation: $19200 \text{bit/s} \times 0.008 \text{s} \approx 154 \text{bit} \rightarrow (9Ah)$
Hex value is 9Ah.

**PROTOCOL**
Here you fix the protocol to be used.
You may choose between:
1: ASCII
2: STX/ETX
3: 3964R
4: USS Master
5: Modbus RTU Master
6: Modbus ASCII Master

**PARAMETER (as DB)**
At ASCII protocol, this parameter is ignored.
At STX/ETX, 3964R, USS and Modbus you fix here a DB that contains the communication parameters and has the following structure for the according protocols:

Data block at STX/ETX

| DBB0: | STX1 | BYTE | (1. Start-ID in hexadecimal) |
The start resp. end sign should always be a value <20, otherwise the sign is ignored!

With not used IDs please always enter FFh!

Data block at 3964R

<table>
<thead>
<tr>
<th>DBB0:</th>
<th>Prio</th>
<th>BYTE</th>
<th>(The priority of both partners must be different)</th>
</tr>
</thead>
<tbody>
<tr>
<td>DBB1:</td>
<td>ConnAttemptNr</td>
<td>BYTE</td>
<td>(Number of connection trials)</td>
</tr>
<tr>
<td>DBB2:</td>
<td>SendAttemptNr</td>
<td>BYTE</td>
<td>(Number of telegram retries)</td>
</tr>
<tr>
<td>DBB4:</td>
<td>CharTimeout</td>
<td>WORD</td>
<td>(Char. delay time)</td>
</tr>
<tr>
<td>DBW6:</td>
<td>ConfTimeout</td>
<td>WORD</td>
<td>(Acknowledgement delay time)</td>
</tr>
</tbody>
</table>

Data block at USS

| DBW0: | Timeout | WORD | (Delay time) |

Data block at Modbus master

| DBW0: | Timeout | WORD | (Respond delay time) |

**BAUDRATE**

Velocity of data transfer in bit/s (baud)

<table>
<thead>
<tr>
<th>BAUDRATE</th>
<th>Velocity (baud)</th>
</tr>
</thead>
<tbody>
<tr>
<td>04h:</td>
<td>1200 baud</td>
</tr>
<tr>
<td>05h:</td>
<td>1800 baud</td>
</tr>
<tr>
<td>06h:</td>
<td>2400 baud</td>
</tr>
<tr>
<td>07h:</td>
<td>4800 baud</td>
</tr>
<tr>
<td>08h:</td>
<td>7200 baud</td>
</tr>
<tr>
<td>09h:</td>
<td>9600 baud</td>
</tr>
<tr>
<td>0Ah:</td>
<td>14400 baud</td>
</tr>
<tr>
<td>0Bh:</td>
<td>19200 baud</td>
</tr>
<tr>
<td>0Ch:</td>
<td>38400 baud</td>
</tr>
<tr>
<td>0Dh:</td>
<td>57600 baud</td>
</tr>
<tr>
<td>0Eh:</td>
<td>115200 baud</td>
</tr>
</tbody>
</table>

**CHARLEN**

Number of data bits where a character is mapped to.

<table>
<thead>
<tr>
<th>CHARLEN</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>0:</td>
<td>5bit</td>
</tr>
<tr>
<td>1:</td>
<td>6bit</td>
</tr>
<tr>
<td>2:</td>
<td>7bit</td>
</tr>
<tr>
<td>3:</td>
<td>8bit</td>
</tr>
</tbody>
</table>

**PARITY**

The parity is -depending on the value- even or odd. For parity control, the information bits are extended with the parity bit, that amends via its value ("0" or "1") the value of all bits to a defined status. If no parity is set, the parity bit is set to "1", but not evaluated.
**STOPBITS**

The stop bits are set at the end of each transferred character and mark the end of a character.

| 1: 1bit | 2: 1.5bit | 3: 2bit |

**FLOWCONTROL**

The parameter `FLOWCONTROL` is ignored. When sending RTS=1, when receiving RTS=0.

**RETV AL FC/SFC 216**

(Return values)

<table>
<thead>
<tr>
<th>Error code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0000h</td>
<td>no error</td>
</tr>
<tr>
<td>809Ah</td>
<td>Interface not found e. g. interface is used by PROFIBUS In the VIPA SLIO CPU with FeatureSet PTP_NO only the ASCII protocol is configurable. If another protocol is selected the FC/SFC216 also left with this error code.</td>
</tr>
<tr>
<td>8x24h</td>
<td>Error at FC/SFC-Parameter x, with x: 1: Error at PROTOCOL 2: Error at PARAMETER 3: Error at BAUDRATE 4: Error at CHARLENGTH 5: Error at PARITY 6: Error at STOPBITS 7: Error at FLOWCONTROL</td>
</tr>
<tr>
<td>809xh</td>
<td>Error in FC/SFC parameter value x, where x: 1: Error at PROTOCOL 3: Error at BAUDRATE 4: Error at CHARLENGTH 5: Error at PARITY 6: Error at STOPBITS 7: Error at FLOWCONTROL</td>
</tr>
<tr>
<td>8092h</td>
<td>Access error in parameter DB (DB too short)</td>
</tr>
<tr>
<td>828xh</td>
<td>Error in parameter x of DB parameter, where x: 1: Error 1. parameter 2: Error 2. parameter  ...</td>
</tr>
</tbody>
</table>
6.5 Communication

6.5.1 Overview

The communication happens via the send and receive blocks FC/SFC 217 (SER_SND) and FC/SFC 218 (SER_RCV). The FCs/SFCs are included in the consignment of the CPU.

6.5.2 FC/SFC 217 - SER_SND

Description

This block sends data via the serial interface. The repeated call of the FC/SFC 217 SER_SND delivers a return value for 3964R, USS and Modbus via RETVAL that contains, among other things, recent information about the acknowledgement of the partner station.

The protocols USS and Modbus require to evaluate the receipt telegram by calling the FC/SFC 218 SER_RCV after SER_SND.

Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Declaration</th>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DATAPTR</td>
<td>IN</td>
<td>ANY</td>
<td>Pointer to Data Buffer for sending data</td>
</tr>
<tr>
<td>DATALEN</td>
<td>OUT</td>
<td>WORD</td>
<td>Length of data sent</td>
</tr>
<tr>
<td>RETVAL</td>
<td>OUT</td>
<td>WORD</td>
<td>Return value (0 = OK)</td>
</tr>
</tbody>
</table>

DATAPTR

Here you define a range of the type Pointer for the send buffer where the data to be sent are stored. You have to set type, start and length.

Example:

Data is stored in DB5 starting at 0.0 with a length of 124 byte.

DataPtr:=P#DB5.DBX0.0 BYTE 124

DATALEN

Word where the number of the sent Bytes is stored.

At ASCII if data were sent by means of FC/SFC 217 faster to the serial interface than the interface sends, the length of data to send could differ from the DATALEN due to a buffer overflow. This should be considered by the user program.

With STX/ETX, 3964R, Modbus and USS always the length set in DATAPTR is stored or 0.

RETVAL FC/SFC 217 (Return values)

Return values of the block:

<table>
<thead>
<tr>
<th>Error code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0000h</td>
<td>Send data - ready</td>
</tr>
<tr>
<td>1000h</td>
<td>Nothing sent (data length 0)</td>
</tr>
<tr>
<td>20xxh</td>
<td>Protocol executed error free with xx bit pattern for diagnosis</td>
</tr>
<tr>
<td>7001h</td>
<td>Data is stored in internal buffer - active (busy)</td>
</tr>
</tbody>
</table>
### Error code

<table>
<thead>
<tr>
<th>Error code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>7002h</td>
<td>Transfer - active</td>
</tr>
<tr>
<td>80xxh</td>
<td>Protocol executed with errors with xx bit pattern for diagnosis (no acknowledgement by partner)</td>
</tr>
<tr>
<td>90xxh</td>
<td>Protocol not executed with xx bit pattern for diagnosis (no acknowledgement by partner)</td>
</tr>
</tbody>
</table>
| 8x24h      | Error in FC/SFC parameter x, where x:  
1: Error in DATAPTR  
2: Error in DATALEN |
| 8122h      | Error in parameter DATAPTR (e.g. DB too short) |
| 807Fh      | Internal error |
| 809Ah      | interface not found e.g. interface is used by PRO-FIBUS |
| 809Bh      | interface not configured |

### ASCII

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>9000h</td>
<td>Buffer overflow (no data send)</td>
</tr>
<tr>
<td>9002h</td>
<td>Data too short (0byte)</td>
</tr>
</tbody>
</table>

### STX/ETX

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>9000h</td>
<td>Buffer overflow (no data send)</td>
</tr>
<tr>
<td>9001h</td>
<td>Data too long (&gt;1024byte)</td>
</tr>
<tr>
<td>9002h</td>
<td>Data too short (0byte)</td>
</tr>
<tr>
<td>9004h</td>
<td>Character not allowed</td>
</tr>
</tbody>
</table>

### 3964R

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2000h</td>
<td>Send ready without error</td>
</tr>
<tr>
<td>80FFh</td>
<td>NAK received - error in communication</td>
</tr>
<tr>
<td>80FEh</td>
<td>Data transfer without acknowledgement of partner or error at acknowledgement</td>
</tr>
<tr>
<td>9000h</td>
<td>Buffer overflow (no data send)</td>
</tr>
<tr>
<td>9001h</td>
<td>Data too long (&gt;1024byte)</td>
</tr>
<tr>
<td>9002h</td>
<td>Data too short (0byte)</td>
</tr>
</tbody>
</table>
### USS

<table>
<thead>
<tr>
<th>Error code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2000h</td>
<td>Send ready without error</td>
</tr>
<tr>
<td>8080h</td>
<td>Receive buffer overflow (no space for receipt)</td>
</tr>
<tr>
<td>8090h</td>
<td>Acknowledgement delay time exceeded</td>
</tr>
<tr>
<td>80F0h</td>
<td>Wrong checksum in respond</td>
</tr>
<tr>
<td>80FEh</td>
<td>Wrong start sign in respond</td>
</tr>
<tr>
<td>80FFh</td>
<td>Wrong slave address in respond</td>
</tr>
<tr>
<td>9000h</td>
<td>Buffer overflow (no data send)</td>
</tr>
<tr>
<td>9001h</td>
<td>Data too long (&gt;1024byte)</td>
</tr>
<tr>
<td>9002h</td>
<td>Data too short (&lt;2byte)</td>
</tr>
</tbody>
</table>

### Modbus RTU/ASCII Master

<table>
<thead>
<tr>
<th>Error code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2000h</td>
<td>Send ready (positive slave respond)</td>
</tr>
<tr>
<td>2001h</td>
<td>Send ready (negative slave respond)</td>
</tr>
<tr>
<td>8080h</td>
<td>Receive buffer overflow (no space for receipt)</td>
</tr>
<tr>
<td>8090h</td>
<td>Acknowledgement delay time exceeded</td>
</tr>
<tr>
<td>80F0h</td>
<td>Wrong checksum in respond</td>
</tr>
<tr>
<td>80FDh</td>
<td>Length of respond too long</td>
</tr>
<tr>
<td>80FEh</td>
<td>Wrong function code in respond</td>
</tr>
<tr>
<td>80FFh</td>
<td>Wrong slave address in respond</td>
</tr>
<tr>
<td>9000h</td>
<td>Buffer overflow (no data send)</td>
</tr>
<tr>
<td>9001h</td>
<td>Data too long (&gt;1024byte)</td>
</tr>
<tr>
<td>9002h</td>
<td>Data too short (&lt;2byte)</td>
</tr>
</tbody>
</table>
Principles of programming

The following text shortly illustrates the structure of programming a send command for the different protocols.

3964R
USS / Modbus

ASCII / STX/ETX
6.5.3 FC/SFC 218 - SER_RCV

**Description**

This block receives data via the serial interface. Using the FC/SFC 218 SER_RCV after SER_SND with the protocols USS and Modbus the acknowledgement telegram can be read.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Declaration</th>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DATAPTR</td>
<td>IN</td>
<td>ANY</td>
<td>Pointer to Data Buffer for received data</td>
</tr>
<tr>
<td>DATALEN</td>
<td>OUT</td>
<td>WORD</td>
<td>Length of received data</td>
</tr>
<tr>
<td>ERROR</td>
<td>OUT</td>
<td>WORD</td>
<td>Error Number</td>
</tr>
<tr>
<td>RETVAL</td>
<td>OUT</td>
<td>WORD</td>
<td>Return value (0 = OK)</td>
</tr>
</tbody>
</table>

**DATAPTR**

Here you set a range of the type Pointer for the receive buffer where the reception data is stored. You have to set type, start and length.

Example:

Data is stored in DB5 starting at 0.0 with a length of 124 byte.

DataPtr:=P#DB5.DBX0.0 BYTE 124

**DATALEN**

Word where the number of received Bytes is stored.

At **STX/ETX** and **3964R**, the length of the received user data or 0 is entered.

At **ASCII**, the number of read characters is entered. This value may be different from the read telegram length.

**ERROR**

This word gets an entry in case of an error.

The following error messages may be created depending on the protocol:

**ASCII**

<table>
<thead>
<tr>
<th>Bit</th>
<th>Error</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>overrun</td>
<td>Overflow, a sign couldn’t be read fast enough from the interface</td>
</tr>
<tr>
<td>1</td>
<td>framing error</td>
<td>Error that shows that a defined bit frame is not coincident, exceeds the allowed length or contains an additional bit sequence (Stop bit error)</td>
</tr>
<tr>
<td>2</td>
<td>parity</td>
<td>Parity error</td>
</tr>
<tr>
<td>3</td>
<td>overflow</td>
<td>Buffer is full</td>
</tr>
</tbody>
</table>
### STX/ETX

<table>
<thead>
<tr>
<th>Bit</th>
<th>Error</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>overflow</td>
<td>The received telegram exceeds the size of the receive buffer.</td>
</tr>
<tr>
<td>1</td>
<td>char</td>
<td>A sign outside the range 20h ... 7Fh has been received.</td>
</tr>
<tr>
<td>3</td>
<td>overflow</td>
<td>Buffer is full.</td>
</tr>
</tbody>
</table>

### 3964R / Modbus RTU/ASCII Master

<table>
<thead>
<tr>
<th>Bit</th>
<th>Error</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>overflow</td>
<td>The received telegram exceeds the size of the receive buffer.</td>
</tr>
</tbody>
</table>

### RETVAL FC/SFC 218 (Return value)

Return values of the block:

<table>
<thead>
<tr>
<th>Error code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0000h</td>
<td>no error</td>
</tr>
<tr>
<td>1000h</td>
<td>Receive buffer too small (data loss)</td>
</tr>
<tr>
<td>8x24h</td>
<td>Error at FC/SFC-Parameter x, with x: 1: Error at DATAPTR 2: Error at DATALEN 3: Error at ERROR</td>
</tr>
<tr>
<td>8122h</td>
<td>Error in parameter DATAPTR (e.g. DB too short)</td>
</tr>
<tr>
<td>809Ah</td>
<td>Serial interface not found res. interface is used by PROFIBUS</td>
</tr>
<tr>
<td>809Bh</td>
<td>Serial interface not configured</td>
</tr>
</tbody>
</table>
6.6 Protocols and procedures

Overview

The CPU supports the following protocols and procedures:

- ASCII communication
- STX/ETX
- 3964R
- USS
- Modbus

ASCII

ASCII data communication is one of the simple forms of data exchange. Incoming characters are transferred 1 to 1. At ASCII, with every cycle the read FC/SFC is used to store the data that is in the buffer at request time in a parameterized receive data block. If a telegram is spread over various cycles, the data is overwritten. There is no reception acknowledgement. The communication procedure has to be controlled by the concerning user application. An according Receive_ASCII FB may be found within the VIPA library in the service area of www.vipa.com.

STX/ETX

STX/ETX is a simple protocol with start and end ID, where STX stands for Start of Text and ETX for End of Text.
Any data transferred from the periphery must be preceded by a Start followed by the data characters and the end character. Depending of the byte width the following ASCII characters can be transferred: 5bit: not allowed; 6bit: 20...3Fh, 7bit: 20...7Fh, 8bit: 20...FFh.

The effective data, which includes all the characters between Start and End are transferred to the CPU when the End has been received.

When data is send from the CPU to a peripheral device, any user data is handed to the FC/SFC 217 (SER_SND) and is transferred with added Start- and End-ID to the communication partner.

You may work with 1, 2 or no Start- and with 1, 2 or no End-ID.

If no End-ID is defined, all read characters are transferred to the CPU after a parametrizable character delay time (Timeout).

As Start-res. End-ID all Hex values from 01h to 1Fh are permissible. Characters above 1Fh are ignored. In the user data, characters below 20h are not allowed and may cause errors. The number of Start- and End-IDs may be different (1 Start, 2 End res. 2 Start, 1 End or other combinations). For not used start and end characters you have to enter FFh in the hardware configuration.

**Message structure:**

```
STX1    STX2    Z1     Z2     Zn     ETX1    ETX2
```

### 3964

The 3964R procedure controls the data transfer of a point-to-point link between the CPU and a communication partner. The procedure adds control characters to the message data during data transfer. These control characters may be used by the communication partner to verify the complete and error free receipt.

The procedure employs the following control characters:

- **STX:** Start of Text
- **DLE:** Data Link Escape
- **ETX:** End of Text
- **BCC:** Block Check Character
- **NAK:** Negative Acknowledge

You may transfer a maximum of 255byte per message.

**Procedure**

<table>
<thead>
<tr>
<th>Active partner</th>
<th>Passive partner</th>
</tr>
</thead>
<tbody>
<tr>
<td>STX</td>
<td>Monitor delayed acknowledgment</td>
</tr>
<tr>
<td>DLE</td>
<td>Message-data</td>
</tr>
<tr>
<td>DLE</td>
<td>ETX</td>
</tr>
<tr>
<td>DLE</td>
<td>BCC</td>
</tr>
<tr>
<td>Monitor delayed acknowledgment</td>
<td>DLE</td>
</tr>
</tbody>
</table>

HB140 | CPU | 314-2BG03 | GB | 14-40 93
When a DLE is transferred as part of the information it is repeated to distinguish between data characters and DLE control characters that are used to establish and to terminate the connection (DLE duplication). The DLE duplication is reversed in the receiving station.

The 3964R procedure requires that a lower priority is assigned to the communication partner. When communication partners issue simultaneous send commands, the station with the lower priority will delay its send command.

### USS

The USS protocol (Universelle serielle Schnittstelle = universal serial interface) is a serial transfer protocol defined by Siemens for the drive and system components. This allows to build-up a serial bus connection between a superordinated master and several slave systems. The USS protocol enables a time cyclic telegram traffic by presetting a fix telegram length.

The following features characterize the USS protocol:

- Multi point connection
- Master slave access procedure
- Single master system
- Max. 32 participants
- Simple and secure telegram frame

It is essential:

- You may connect 1 master and max. 31 slaves at the bus
- The single slaves are addressed by the master via an address sign in the telegram.
- The communication happens exclusively in half-duplex operation.
- After a send command, the acknowledgement telegram must be read by a call of the FC/SFC 218 SER_RCV.

The telegrams for send and receive have the following structure:

#### Master slave telegram

<table>
<thead>
<tr>
<th>STX</th>
<th>LGE</th>
<th>ADR</th>
<th>PKE</th>
<th>IND</th>
<th>PWE</th>
<th>STW</th>
<th>HSW</th>
<th>BCC</th>
</tr>
</thead>
<tbody>
<tr>
<td>02h</td>
<td></td>
<td></td>
<td></td>
<td>H</td>
<td>L</td>
<td>H</td>
<td>L</td>
<td>H</td>
</tr>
</tbody>
</table>

#### Slave master telegram

<table>
<thead>
<tr>
<th>STX</th>
<th>LGE</th>
<th>ADR</th>
<th>PKE</th>
<th>IND</th>
<th>PWE</th>
<th>ZSW</th>
<th>HIW</th>
<th>BCC</th>
</tr>
</thead>
<tbody>
<tr>
<td>02h</td>
<td></td>
<td></td>
<td></td>
<td>H</td>
<td>L</td>
<td>H</td>
<td>L</td>
<td>H</td>
</tr>
</tbody>
</table>
with
STX - Start sign
STW - Control word
LGE - Telegram length
ZSW - State word
ADR - Address
HSW - Main set value
PKE - Parameter ID
HIW - Main effective value
IND - Index
BCC - Block Check Character
PWE - Parameter value

**Broadcast with set bit 5 in ADR byte**

<table>
<thead>
<tr>
<th>7</th>
<th>6</th>
<th>5</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1</td>
</tr>
</tbody>
</table>

A request can be directed to a certain slave or be send to all slaves as broadcast message. For the identification of a broadcast message you have to set bit 5 to 1 in the ADR byte. Here the slave addr. (bit 0 ... 4) is ignored. In opposite to a "normal" send command, the broadcast does not require a telegram evaluation via FC/SFC 218 SER_RCV. Only write commands may be sent as broadcast.

**Modbus**

- The Modbus protocol is a communication protocol that fixes a hierarchic structure with one master and several slaves.
- Physically, Modbus works with a serial half-duplex connection. There are no bus conflicts occurring, because the master can only communicate with one slave at a time.
- After a request from the master, this waits for a preset delay time for an answer of the slave. During the delay time, communication with other slaves is not possible.
- After a send command, the acknowledgement telegram must be read by a call of the FC/SFC 218 SER_RCV.
- The request telegrams send by the master and the respond telegrams of a slave have the following structure:

**Telegram structure**

<table>
<thead>
<tr>
<th>Start sign</th>
<th>Slave address</th>
<th>Function Code</th>
<th>Data</th>
<th>Flow control</th>
<th>End sign</th>
</tr>
</thead>
</table>

**Broadcast with slave address = 0**

- A request can be directed to a special slave or at all slaves as broadcast message.
- To mark a broadcast message, the slave address 0 is used.
- In opposite to a "normal" send command, the broadcast does not require a telegram evaluation via FC/SFC 218 SER_RCV.
- Only write commands may be sent as broadcast.
Modbus offers 2 different transfer modes. The mode selection happens during runtime by using the FC/SFC 216 SER_CFG.

- **ASCII mode**: Every byte is transferred in the 2 sign ASCII code. The data are marked with a start and an end sign. This causes a transparent but slow transfer.
- **RTU mode**: Every byte is transferred as one character. This enables a higher data pass through as the ASCII mode. Instead of start and end sign, a time control is used.

**Supported Modbus protocols**

The following Modbus Protocols are supported by the RS485 interface:

- Modbus RTU Master
- Modbus ASCII Master

**6.7 Modbus - Function codes**

**Naming convention**

| Bit = Coil | IN: "Input Status" | OUT: "Coil Status" |
| Word = Register | IN: "Input Register" | OUT: "Holding Register" |

- Modbus differentiates between bit and word access; bits = "Coils" and words = "Register".
- Bit inputs are referred to as "Input-Status" and bit outputs as "Coil-Status".
- Word inputs are referred to as "Input-Register" and word outputs as "Holding-Register".

**Range definitions**

Normally the access at Modbus happens by means of the ranges 0x, 1x, 3x and 4x.

0x and 1x gives you access to digital bit areas and 3x and 4x to analog word areas.

For the CPs from VIPA is not differentiating digital and analog data, the following assignment is valid:

- **0x** - Bit area for master output data
  Access via function code 01h, 05h, 0Fh
- **1x** - Bit area for master input data
  Access via function code 02h
- **3x** - Word area for master input data
  Access via function code 04h
- **4x** - Word area for master output data
  Access via function code 03h, 06h, 10h
A description of the function codes follows below.

**Overview**

With the following Modbus function codes a Modbus master can access a Modbus slave: With the following Modbus function codes a Modbus master can access a Modbus slave. The description always takes place from the point of view of the master:

<table>
<thead>
<tr>
<th>Code</th>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>01h</td>
<td>Read n bits</td>
<td>Read n bits of master output area 0x</td>
</tr>
<tr>
<td>02h</td>
<td>Read n bits</td>
<td>Read n bits of master input area 1x</td>
</tr>
<tr>
<td>03h</td>
<td>Read n words</td>
<td>Read n words of master output area 4x</td>
</tr>
<tr>
<td>04h</td>
<td>Read n words</td>
<td>Read n words master input area 3x</td>
</tr>
<tr>
<td>05h</td>
<td>Write 1 bit</td>
<td>Write 1 bit to master output area 0x</td>
</tr>
<tr>
<td>06h</td>
<td>Write 1 word</td>
<td>Write 1 word to master output area 4x</td>
</tr>
<tr>
<td>0Fh</td>
<td>Write n bits</td>
<td>Write n bits to master output area 0x</td>
</tr>
<tr>
<td>10h</td>
<td>Write n words</td>
<td>Write n words to master output area 4x</td>
</tr>
</tbody>
</table>

**Point of View of "Input" and "Output" data**

The description always takes place from the point of view of the master. Here data, which were sent from master to slave, up to their target are designated as "output" data (OUT) and contrary slave data received by the master were designated as "input" data (IN).

**Respond of the slave**

If the slave announces an error, the function code is send back with an "ORed" 80h.
Without an error, the function code is sent back.

<table>
<thead>
<tr>
<th>Slave answer:</th>
<th>Function code OR 80h → Error</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Function code → OK</td>
</tr>
</tbody>
</table>

### Byte sequence in a word

<table>
<thead>
<tr>
<th>1 word</th>
</tr>
</thead>
<tbody>
<tr>
<td>High-byte</td>
</tr>
<tr>
<td>Low-byte</td>
</tr>
</tbody>
</table>

### Check sum CRC, RTU, LRC

The shown check sums CRC at RTU and LRC at ASCII mode are automatically added to every telegram. They are not shown in the data block.

### Read n bits 01h, 02h

- Code 01h: Read n bits of master output area 0x
- Code 02h: Read n bits of master input area 1x

### Command telegram

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>Address 1. bit</th>
<th>Number of bits</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 byte</td>
<td>1 byte</td>
<td>1 word</td>
<td>1 word</td>
<td>1 word</td>
</tr>
</tbody>
</table>

### Respond telegram

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>Number of read bytes</th>
<th>Data 1. byte</th>
<th>Data 2. byte</th>
<th>...</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 byte</td>
<td>1 byte</td>
<td>1 byte</td>
<td>1 byte</td>
<td>1 byte</td>
<td></td>
<td>1 word</td>
</tr>
<tr>
<td></td>
<td></td>
<td>max. 250byte</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Read n words 03h, 04h

- 03h: Read n words of master output area 4x
04h: Read n words master input area 3x

Command telegram

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>Address 1. bit</th>
<th>Number of words</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1byte</td>
<td>1byte</td>
<td>1word</td>
<td>1word</td>
<td>1word</td>
</tr>
</tbody>
</table>

Respond telegram

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>Number of read bytes</th>
<th>Data 1. word</th>
<th>Data 2. word</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1byte</td>
<td>1byte</td>
<td>1byte</td>
<td>1word</td>
<td>1word</td>
<td>1word</td>
</tr>
</tbody>
</table>

Code 05h: Write 1 bit to master output area 0x
A status change is via "Status bit" with following values:
"Status bit" = 0000h → Bit = 0
"Status bit" = FF00h → Bit = 1

Command telegram

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>Address bit</th>
<th>Status bit</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1byte</td>
<td>1byte</td>
<td>1word</td>
<td>1word</td>
<td>1word</td>
</tr>
</tbody>
</table>

Respond telegram

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>Address bit</th>
<th>Status bit</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1byte</td>
<td>1byte</td>
<td>1word</td>
<td>1word</td>
<td>1word</td>
</tr>
</tbody>
</table>
### Write 1 word 06h

Code 06h: Write 1 word to master output area 4x

**Command telegram**

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>Address word</th>
<th>Value word</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1byte</td>
<td>1byte</td>
<td>1word</td>
<td>1word</td>
<td>1word</td>
</tr>
</tbody>
</table>

**Respond telegram**

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>Address word</th>
<th>Value word</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1byte</td>
<td>1byte</td>
<td>1word</td>
<td>1word</td>
<td>1word</td>
</tr>
</tbody>
</table>

### Write n bits 0Fh

Code 0Fh: Write n bits to master output area 0x

Please regard that the number of bits has additionally to be set in byte.

**Command telegram**

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>Address 1. bit</th>
<th>Number of bits</th>
<th>Number of bytes</th>
<th>Data 1. byte</th>
<th>Data 2. byte</th>
<th>...</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1byte</td>
<td>1byte</td>
<td>1word</td>
<td>1word</td>
<td>1byte</td>
<td>1byte</td>
<td>1byte</td>
<td>1byte</td>
<td></td>
</tr>
</tbody>
</table>

| 1byte         | 1byte        | 1word          | 1word          | 1byte          | 1byte       | 1byte       | 1byte | max. 250byte     |

**Respond telegram**

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>Address 1. bit</th>
<th>Number of bits</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1byte</td>
<td>1byte</td>
<td>1word</td>
<td>1word</td>
<td>1word</td>
</tr>
</tbody>
</table>
Write n words 10h

Code 10h: Write n words to master output area 4x

Command telegram

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>Address 1. word</th>
<th>Number of words</th>
<th>Number of bytes</th>
<th>Data 1. word</th>
<th>Data 2. word</th>
<th>...</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 byte</td>
<td>1 byte</td>
<td>1 word</td>
<td>1 word</td>
<td>1 byte</td>
<td>1 word</td>
<td>1 word</td>
<td>1 word</td>
<td>1 word</td>
</tr>
</tbody>
</table>

max. 125 words

Respond telegram

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>Address 1. word</th>
<th>Number of words</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 byte</td>
<td>1 byte</td>
<td>1 word</td>
<td>1 word</td>
<td>1 word</td>
</tr>
</tbody>
</table>

6.8 Modbus - Example communication

Overview

The example establishes a communication between a master and a slave via Modbus. The following combination options are shown:

- CPU 31xS as Modbus RTU master
- CPU 21xSER-1 as Modbus RTU slave
- Siemens SIMATIC Manager and possibilities for the project transfer
- Modbus cable connection

Approach

1. Assemble a Modbus system consisting of a CPU 31xS as Modbus master and a CPU 21xSER-1 as Modbus slave and Modbus cable.

2. Execute the project engineering of the master! For this you create a PLC user application with the following structure:

   - OB 100:
     Call SFC 216 (configuration as Modbus RTU master) with timeout setting and error evaluation.
   - OB 1:
     Call SFC 217 (SER_SND) where the data is send with error evaluation. Here you have to build up the telegram according to the Modbus rules. Call SFC 218 (SER_RECV) where the data is received with error evaluation.
3. Execute the project engineering of the slave! The PLC user application at the slave has the following structure:

- **OB 100:**
  Call SFC 216 (configuration as Modbus RTU slave) with timeout setting and Modbus address in the DB and error evaluation.

- **OB 1:**
  Call SFC 217 (SER_SND) for data transport from the slave CPU to the output buffer. Call SFC 218 (SER_RECV) for the data transport from the input buffer to the CPU. Allow an according error evaluation for both directions.

Structure for the according PLC programs for master and slave:
7 Deployment PROFIBUS communication

7.1 Overview

**PROFIBUS DP**
- PROFIBUS is an international standard applicable to an open and serial field bus for building, manufacturing and process automation that can be used to create a low (sensor-/actuator level) or medium (process level) performance network of programmable logic controllers.
- PROFIBUS comprises an assortment of compatible versions. The following details refer to PROFIBUS DP.
- PROFIBUS DP is a special protocol intended mainly for automation tasks in a manufacturing environment. DP is very fast, offers Plug’n’Play facilities and provides a cost-effective alternative to parallel cabling between PLC and remote I/O. PROFIBUS DP was designed for high-speed data communication on the sensor-actuator level.
- The data transfer referred to as "Data Exchange" is cyclical. During one bus cycle, the master reads input values from the slaves and writes output information to the slaves.

**DP slave operation**
For the deployment in a super-ordinated master system you first have to project your slave system as Siemens CPU in slave operation mode with configured in-/output areas. Afterwards you configure your master system. Couple your slave system to your master system by dragging the CPU 31x from the hardware catalog at **Configured stations** onto the master system, choose your slave system and connect it.

**Firmware update**
The firmware update of the integrated PROFIBUS part happens automatically by the firmware update of the CPU.

**On delivery**
On delivery the CPU is overall reset. The PROFIBUS part is de-activated after PowerON.

**Behavior at CPU STOP**
With every change of the RUN STOP state of the CPU, the DP slave sends a diagnostics telegram to the subordinated DP master. Independent on the CPU state the DP slave remains in data exchange.
7.2 Deployment as PROFIBUS DP slave

**Fast introduction**

In the following the deployment of the PROFIBUS section as "intelligent" DP slave on master system is described, which exclusively may be configured in the Siemens SIMATIC Manager. The following steps are required:

1. Configure a station with a CPU with operating mode DP slave.
2. Connect to PROFIBUS and configure the in-/output area for the slave section.
3. Save and compile your project.
4. Configure another station with another CPU with operating mode DP master.
5. Connect to PROFIBUS and configure the in-/output ranges for the master section.
6. Save, compile and transfer your project to your CPU.

**Project engineering of the slave section**

1. Start the Siemens SIMATIC Manager and configure the CPU 315-2AG10 (6ES7 315-2AG10-0AB0/V2.6) from Siemens.
2. Designate the station as "...DP slave".
3. Add your modules according to the real hardware assembly.
4. Open the properties dialog of the DP interface of the CPU by means of a double-click at ‘DP’.
5. Set Interface type to "PROFIBUS".
6. Connect to PROFIBUS and preset an address (e.g. 3) and confirm with [OK].
7. Switch at Operating mode to "DP slave".
8. Via Configuration you define the in-/output address area of the slave CPU, which are to be assigned to the DP slave.
9. Save, compile and transfer your project to your CPU.

**Slave section**

<table>
<thead>
<tr>
<th>Slot</th>
<th>Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>CPU</td>
</tr>
<tr>
<td>3</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>...</td>
</tr>
<tr>
<td>5</td>
<td>Modules</td>
</tr>
</tbody>
</table>

**Object properties**

- Operating mode: DP slave
- Connect: PROFIBUS
- PROFIBUS address: > 1
- Configuration:
  - Input area
  - Output area

**Project engineering of the master section**

1. Insert another station and configure a CPU.
2. Designate the station as "...DP master".
3. Add your modules according to the real hardware assembly.
4. Open the properties dialog of the DP interface of the CPU by means of a double-click at ‘MPI/DP’.
5. Set Interface: type to "PROFIBUS".
6. Connect to PROFIBUS and preset an address (e.g. 2) and confirm with [OK].
7. Switch at Operating mode to "DP master" and confirm the dialog with [OK].
8. Connect your slave system to this master system by dragging the "CPU 31x" from the hardware catalog at Configured stations onto the master system and select your slave system to be coupled.
9. Open the Configuration at Object properties of your slave system.
10. Via double click to the according configuration line you assign the according input address area on the master CPU to the slave output data and the output address area to the slave input data.
11. Save, compile and transfer your project to your CPU.
7.3 PROFIBUS installation guidelines

PROFIBUS in general
- A PROFIBUS DP network may only be built up in linear structure.
- PROFIBUS DP consists of minimum one segment with at least one master and one slave.
- A master has always been deployed together with a CPU.
- PROFIBUS supports max. 126 participants.
- Per segment a max. of 32 participants is permitted.
- The max. segment length depends on the transfer rate:
  - 9.6 ... 187.5bit/s → 1000m
  - 500kbit/s → 400m
  - 1.5Mbit/s → 200m
  - 3 ... 12Mbit/s → 100m
- Max. 10 segments may be built up. The segments are connected via repeaters. Every repeater counts for one participant.
- The bus respectively a segment is to be terminated at both ends.
- All participants are communicating with the same transfer rate. The slaves adjust themselves automatically on the transfer rate.

Transfer medium
- As transfer medium PROFIBUS uses an isolated twisted-pair cable based upon the RS485 interface.
- The RS485 interface is working with voltage differences. Though it is less irritable from influences than a voltage or a current interface. You are able to configure the network as well linear as in a tree structure.
- Max. 32 participants per segment are permitted. Within a segment the members are linear connected. The segments are connected via repeaters. The maximum segment length depends on the transfer rate.
- PROFIBUS DP uses a transfer rate between 9.6kbit/s and 12Mbit/s, the slaves are following automatically. All participants are communicating with the same transfer rate.
- The bus structure under RS485 allows an easy connection respectively disconnection of stations as well as starting the system step by step. Later expansions don’t have any influence on stations that are already integrated. The system realizes automatically if one partner had a fail down or is new in the network.

Bus connection
- The following picture illustrates the terminating resistors of the respective start and end station.
The PROFIBUS line has to be terminated with its ripple resistor. Please make sure to terminate the last participants on the bus at both ends by activating the terminating resistor.

**EasyConn bus connector**

In PROFIBUS all participants are wired parallel. For that purpose, the bus cable must be feed-through. Via the order number 972-0DP10 you may order the bus connector "EasyConn". This is a bus connector with switchable terminating resistor and integrated bus diagnostic.

<table>
<thead>
<tr>
<th>Dimensions in mm</th>
<th>0°</th>
<th>45°</th>
<th>90°</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>64</td>
<td>61</td>
<td>66</td>
</tr>
<tr>
<td>B</td>
<td>34</td>
<td>53</td>
<td>40</td>
</tr>
<tr>
<td>C</td>
<td>15.8</td>
<td>15.8</td>
<td>15.8</td>
</tr>
</tbody>
</table>
To connect this EasyConn plug, please use the standard PROFIBUS cable type A (EN50170). Starting with release 5 you also can use highly flexible bus cable:

Lapp Kabel order no: 2170222, 2170822, 2170322.

With the order no. 905-6AA00 VIPA offers the "EasyStrip" de-isolating tool that makes the connection of the EasyConn much easier.

Dimensions in mm

Termination with "EasyConn"
The "EasyConn" bus connector is provided with a switch that is used to activate a terminating resistor.

Wiring

[1] 1. last bus participant
[2] further participants

CAUTION!
The terminating resistor is only effective, if the connector is installed at a bus participant and the bus participant is connected to a power supply.

The tightening torque of the screws to fix the connector to a device must not exceed 0.02Nm!

A complete description of installation and deployment of the terminating resistors is delivered with the connector.
**Assembly**

1. Loosen the screw.
2. Lift contact-cover.
3. Insert both wires into the ducts provided (watch for the correct line colour as below!)
4. Please take care not to cause a short circuit between screen and data lines!
5. Close the contact cover.
6. Tighten screw (max. tightening torque 0.08Nm).

> The green line must be connected to A, the red line to B!
8 WinPLC7

8.1 System conception

General

WinPLC7 is a programming and simulation software from VIPA for every PLC programmable with Siemens STEP®7. This tool allows you to create user applications in FBD, LAD and STL. Besides of a comfortable programming environment, WinPLC7 has an integrated simulator that enables the simulation of your user application at the PC without additional hardware. This "Soft-PLC" is handled like a real PLC and offers the same error behavior and diagnostics options via diagnostics buffer, USTACK and BSTACK.

Detailed information and programming samples may be found at the online help respectively in the online documentation of WinPLC7.

Alternatives

There is also the possibility to use according configuration tools from Siemens instead of WinPLC7 from VIPA. Here the proceeding is part of this manual.

System requirements

- Windows XP (SP3)
- Windows Vista
- Windows 7 (32 and 64 bit)
- Windows 8 (32 and 64 bit)

Source

You may receive a demo version from VIPA. Without any activation with the demo version the CPUs 11x of the System 100V from VIPA may be configured. To configure the SPEED7 CPUs a license for the "profi" version is necessary. This may be online be received from VIPA and activated.

There are the following sources to get WinPLC7:

- Online
  - At www.vipa.com in the service area at Downloads a link to the current demo version and the updates of WinPLC7 may be found.
- CD
  - SW211C1DD: WinPLC7 Single license, CD, with documentation in german
  - SW211C1ED: WinPLC7 Single license, CD, with documentation in english

8.2 Installation

Precondition

The project engineering of a SPEED7 CPU from VIPA with WinPLC7 is only possible using an activated "Profi" version of WinPLC7.
Installation WinPLC7 Demo

The installation and the registration of WinPLC7 has the following approach:

1. For installation of WinPLC7 start the setup program of the corresponding CD respectively execute the online received exe file.
2. Select the according language.
3. Accept the licensing agreement.
4. Set an installation directory and a group assignment and start the installation.

Activation of the "Profi" version

   ⇒ A ‘Demo’ dialog is shown
2. Click at [Activate Software].
   ⇒ The following dialog for activation is shown:

3. Fill in the following fields:
   - Email-Addr.
   - Your Name
   - Serial number
     - The serial number may be found on a label at the CD case of WinPLC7.

4. If your computer is connected to Internet you may online request the Activation Key by [Get activation key via Internet]. Otherwise click at [This PC has no access to the Internet] and follow the instructions.
   ⇒ With successful registration the activation key is listed in the dialog window respectively is sent by email.

5. Enter this at 'Activation code' and click at [OK].
   ⇒ Now, WinPLC7 is activated as "Profi" version.
Installation of WinPCAP for station search via Ethernet

To find a station via Ethernet (accessible nodes) you have to install the WinPCAP driver. This driver may be found on your PC in the installation directory at WinPS-S7-V5/WinPcap_... .exe. Execute this file and follow the instructions.

8.3 Example project engineering

8.3.1 Job definition

In the example a FC 1 is programmed, which is cyclically called by the OB 1. By setting of 2 comparison values (value1 and value2) during the FC call, an output of the PLC-System should be activated depending on the comparison result. By setting of 2 comparison values (value1 and value2) during the FC call, an output of the PLC-System should be activated depending on the comparison result.

Here it should apply:

- if value1 = value2 activate output Q 124.0
- if value1 > value2 activate output Q 124.1
- if value1 < value2 activate output Q 124.2

Precondition

- You have administrator rights for your PC.
- WinPLC7 is installed and activated as "Profi" version.
- One SPEED7 CPU and one digital output module are installed and cabled.
- The Ethernet PG/OP channel of the CPU is connected to your Ethernet network. Your CPU may be connected to your PC with an Ethernet cable either directly or via hub/switch.
- WinPCap for station search via Ethernet is installed.
- The power supply of the CPU and the I/O periphery are activated and the CPU is in STOP state.

8.3.2 Project engineering

1. Start WinPLC7 ("Profi" version)
2. Create and open a new project with [Create a new solution].

Hardware configuration

1. For the call of the hardware configurator it is necessary to set WinPLC7 from the Simulator-Mode to the Offline-Mode. For this and the communication via Ethernet set "Target: TCP/IP Direct".

2. Double click to ‘Hardware stations’ and here at ‘Create new’.
3. Enter a station name. Please consider that the name does not contain any spaces.

4. After the load animation choose in the register Select PLC-System the system "VIPA SPEED7" and click to [Create]. A new station is created.

5. Save the empty station with [Strg]+[S].

6. By double click or drag&drop the according VIPA CPU in the hardware catalog at 'CPU SPEED7' the CPU is inserted to your configuration.

7. For output place a digital output module, assign the start address 124 and save the hardware configuration.

Establish online access via Ethernet PG/OP channel:

1. Open the CPU-Properties, by double clicking to the CPU at slot 2 in the hardware configurator.

2. Click to the button [Ethernet CP-Properties (PG/OP-channel)].
   ⇒ The dialog ‘Properties CP343’ is opened.

3. Chose the register ‘Common Options’.

4. Click to [Properties Ethernet].

5. Choose the subnet ‘PG_OP_Ethernet’.

6. Enter a valid IP address-and a subnet mask. You may get this from your system administrator.

7. Close every dialog window with [OK].

8. Select, if not already done, ‘Target: External TCP/IP direct’.

9. Open with ‘Online ➔ Send configuration to the CPU’ a dialog with the same name.

10. Click to [Accessible nodes]. Please regard to use this function it is necessary to install WinPCap before!

11. Choose your network card and click to [Determining accessible nodes].

   ⇒ After a waiting time every accessible station is listed. Here your CPU with IP 0.0.0.0 is listed, too. To check this the according MAC address is also listed. This MAC address may be found at a label beneath the front flap of the CPU.

12. For the temporary setting of an IP address select you CPU and click to [Temporary setting of the IP parameters]. Please enter the same IP parameters, you configured in the CPU properties and click to [Write Parameters].

13. Confirm the message concerning the overall reset of the CPU.

   ⇒ The IP parameters are transferred to the CPU and the list of accessible stations is refreshed.

14. Select your CPU and click to [Confirm].

   ⇒ Now you are back in the dialog "Send configuration".
Transfer hardware configuration

Choose your network card and click to [Send configuration].

⇒ After a short time a message is displayed concerning the transfer of the configuration is finished.

The hardware configuration is finished, now and the CPU may always be accessed by the IP parameters as well by means of WinPLC7.

Usually the online transfer of the hardware configuration happens within the hardware configurator. With 'File ➔ Save active station in the WinPL7 sub project' there is also the possibility to store the hardware configuration as a system file in WinPLC7 to transfer it from WinPLC7 to the CPU.

Programming of the FC 1

The PLC programming happens by WinPLC7. Close the hardware configurator and return to your project in WinPLC7. The PLC program is to be created in the FC 1.

1. In ‘Project content’ choose ‘New ➔ FC’.

2. Enter "FC1" as block and confirm with [OK].

⇒ The editor for FC 1 is called.

Creating parameters

In the upper part of the editor there is the parameter table. In this example the 2 integer values value1 and value2 are to be compared together. Since both values are read only by the function, these are to be defined as "in".

1. Select the ‘in ➔’ row at the ‘parameter table’ and enter at the field ‘Name’ “value1”. Press the [Return] key.

⇒ The cursor jumps to the column with the data type.

2. The data type may either directly be entered or be selected from a list of available data types by pressing the [Return] key. Set the data type to INT and press the [Return] key.

⇒ Now the cursor jumps to the ‘Comment’ column.
3. Here enter "1. compare value" and press the [Return] key.
   ➞ A new 'in ➔' row is created and the cursor jumps to 'Name'.

4. Proceed for value2 in the same way as described for value1.

5. Save the block. A note that the interface of the block was changed may be acknowledged with [Yes].
   ➞ The parameter table shows the following entries, now:

<table>
<thead>
<tr>
<th>Address</th>
<th>Declaration</th>
<th>Name</th>
<th>Type</th>
<th>Initial value</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>20</td>
<td>INT</td>
<td>value1</td>
<td>INT</td>
<td>1, compare value</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>INT</td>
<td>value2</td>
<td>INT</td>
<td>2, compare value</td>
<td></td>
</tr>
</tbody>
</table>

Enter the program
As requested in the job definition, the corresponding output is activated depending on the comparison of value1 and value2. For each comparison operation a separate network is to be created.

1. The program is to be created as FBD (function block diagram). Here change to the FBD view by clicking at 'FBD'.

2. Click to the input field designated as "<empty>". The available operations may be added to your project by drag&drop from the hardware catalog or by double click at them in the hardware catalog.

3. Open in the catalog the category "Comparator" and add the operation 'CMP==I' to your network.

4. Click to the input left above and insert value1. Since these are block parameters a selection list of block parameters may be viewed by entering "#".

5. Type in "#" and press the [Return] key.

6. Choose the corresponding parameter of the list and confirm it with the [Return] key.
7. Proceed in the same way with the parameter value2.

The allocation to the corresponding output, here Q 124.0, takes place with the following proceeding:

1. Click to the output at the right side of the operator.

2. Open in the catalog the category ‘Bit logic’ and select the function ‘\--[=\]’. The inserting of ‘\--[=\]’ corresponds to the WinPLC7 shortcut [F7].

3. Insert the output Q 124.0 by clicking to the operand.

⇒ Network1 is finished, now.

Adding a new network

For further comparisons the operations "CMP>I" at Q 124.1 and "CMP<I" at Q 124.2 are necessary. Create a network for both operations with the following proceeding:

1. Move your mouse at an arbitrary position on the editor window and press the right mouse key.

2. Select at ‘context menu’ ⇒ Insert new network’.  
⇒ A dialog field is opened to enter the position and number of the networks.

3. Proceed as described for "Network 1".
4. Save the FC 1 with ‘File ➤ Save content of focused window’ respectively press [Strg]+[S].

After you have programmed the still missing networks, the FC 1 has the following structure:

Creating the block OB 1

The FC 1 is to be called from the cycle OB 1.

1. Go to OB 1, which was automatically created with starting the project.

2. Go to ‘Project content’ or to ‘Solution’ and open the OB 1 by a double click.

3. Change to the STL view.
4. Type in "Call FC 1" and press the [Return] key.
   ⇒ The FC parameters are automatically displayed and the following parameters are assigned:
   "Cyclic main program"

   Block comment=

   
   Network comment=

   0 | CALL FC 1  
   1 | value1:=10  
   2 | value2:=10  
   3 |

5. Save the OB 1 with respectively press [Strg]+[S].

8.3.3 Test the PLC program in the Simulator

Proceeding

With WinPLC7 there is the possibility to test your project in a Simulator.

1. Here select ‘Target: Simulator’.

2. Transfer the blocks to the simulator with [Load all blocks into the PLC].

3. Switch the CPU to RUN, by clicking at ‘RUN’ in the ‘CPU Control Center’ of ‘Edit project’.
   ⇒ The displayed state changes from STOP to RUN.

4. To view the process image select ‘View
   ⇒ Display process image window’ or click at .
   ⇒ The various areas are displayed.

5. Double click to the process image and enter at ‘Line 2’ the address PQB 124. Confirm your input with [OK]. A value marked by red color corresponds to a logical "1".

6. Open the OB 1.
7. Change the value of one variable, save the OB 1 and transfer it to the simulator.
   ⇒ According to your settings the process image changes immediately. The status of your blocks may be displayed with ‘Block ➔ Monitoring On/Off’.

Visualization via PLC mask

A further component of the simulator is the PLC mask. Here a CPU is graphically displayed, which may be expanded by digital and analog peripheral modules. As soon as the CPU of the simulator is switched to RUN state, inputs may be activated by mouse and outputs may be displayed.

1. Open the PLC mask with ‘view ➔ PLC mask’.
   ⇒ A CPU is graphically displayed.

2. Double-click to the output module, open its properties dialog and enter the Module address 124.

3. Switch the operating mode switch to RUN by means of the mouse.
   ⇒ Your program is executed and displayed in the simulator, now.

8.3.4 Transfer PLC program to CPU and its execution

Proceeding

1. For transfer to the CPU set the transfer mode to "Target: TCP/IP-Direct".

2. If there are more network adapters in your PC, the network adapter may be selected via ‘Extras ➔ Select network adapter’.

3. For presetting the Ethernet data click to [...] and click to [Accessible nodes].
4. Click at [Determining accessible nodes].
   ➞ After a waiting time every accessible station is listed.

5. Choose your CPU, which was provided with TCP/IP address parameters during the hardware configuration and click to [Confirm].

6. Close the dialog ‘Ethernet properties’ with [OK].

7. Transfer your project to your CPU with ‘PLC ➔ Send all blocks’.

8. Switch your CPU to RUN state.

9. Open the OB 1 by double click.

10. Change the value of one variable, save the OB 1 and transfer it to the CPU.
    ➞ According to your settings the process image changes immediately. The status of your blocks may be displayed with ‘Block ➔ Monitoring On/Off’.